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Server Administration
Universal Type Server® is the next generation of workgroup font management software. Written for the
latest operating systems, this cross-platform system combines the power, speed, and control that
administrators need with the seamless font delivery and elegant interface that users expect.

Type Server® provides centralized control, consistency, and compliance for all levels of font
management—administrators as well as client users. Administrators can rest assured that the
appropriate fonts are available to the client when they need them, and rogue fonts are kept out of the
workflow. Meanwhile, users are certain that they are using the correct, approved fonts for their projects
by using the Universal Type Client™.

If you have just installed Universal Type Server and want to get going quickly, you should do these
things:

Activate your license in the Management application. (This application will launch automatically when
you install Universal Type Server.)
1. Log in to the Management application.

To start Management manually, open a web browser on the Type Server system and enter
localhost:8080 in the address bar.
(If you are using a computer other than the Type Server system, you can launch the Management
application using the Type Server’s IP address and port 8080; for example, 123.45.67.89:8080.)
The account name is administrator and the default password is password.

2. Click the Administration tab, then click Licenses.
3. Click Activate Universal Type Server.
4. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.

Change the default administrator password.
1. In the Management application, click the Users tab.
2. In the Users panel on the left, click administrator.
3. In the User Account Data panel on the right, click Account.
4. Enter your new password in the Password field, then enter it again in theConfirm Password

field.
5. Click Save.

For further configuration steps, see Installation overview on page 9.
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About the Server Administration Guide
This Server Administration guide provides instructions for installing and configuring the server, as well as
general server management information.

Universal Type Server is administered through three primary applications: the Server Administration
application, the User Management application, and the Universal Type Client. In addition, Enterprise
installations have access to the Universal Type Core Client for users that do not have changing font
needs.

For detailed instructions about configuring roles, workgroups and users, please see the User
Management Guide, or the help system available within the application.

All management of the physical font files such as adding fonts to the server is accomplished in the
Universal Type Client. Other administrative functions such as running license reports are also performed
from the Type Client. For information about these features as well as all other client operations, please
see the Universal Type Client User Guide or choose Help > Universal Type Client Help.

What’s new
IMPORTANT: An internet connection is required for the activation and use of Universal Type Server.
See Entering serial numbers into Universal Type Server version 7.0.2 or later.

Universal Type Client 7.0.10
n We have added an auto-activation plug-in for Adobe After Effects CC 2021.

Universal Type Client 7.0.9
n We have validated Universal Type Client for macOS 11.x and Apple M1 systems.

(Universal Type Client runs on Apple M1 systems using Rosetta 2 emulation.)

Universal Type Client 7.0.7
n Auto-activation plug-ins for Adobe Creative Cloud 2021 releases of Illustrator, InCopy, InDesign,

and Photoshop.
n Extensis Font Panel for Adobe CC 2021 releases of Illustrator, InDesign, and Photoshop.

Version 7.0.6
n Type Server: We added support for PostgreSQL as an external database.
n Type Client: We added a confirmation dialog when deleting a user-created font attribute.

IMPORTANT: Support for Microsoft SQL Server and MySQL has been discontinued. While we support
these external databases in the current release of Universal Type Server, they will be dropped in a
future release. Tomigrate to a supported database, please seeConverting between database
types on page 39.

Universal Type Client 7.0.4
n Support for macOSCatalina.
n Auto-activation plug-ins for Adobe Creative Cloud 2020 releases of After Effects, Illustrator,

InCopy, InDesign, and Photoshop.
n Extensis Font Panel for Adobe CC 2020 releases of Illustrator, InDesign, and Photoshop.
n Auto-activation plug-in for Sketch.

Entering serial numbers: https://help.extensis.com/hc/en-us/articles/360018517534

https://help.extensis.com/hc/en-us/articles/360018517534
https://help.extensis.com/hc/en-us/articles/360018517534
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Version 7.0.3
n The Windows Core Client now enforces the System Font Policy.
n Universal Type Client includes in-app messaging to provide important product information.
n We have added set creation and activation capability to the Adobe Fonts library.
n We have added an auto-activation plug-in for QuarkXPress 2019.

Version 7.0.2
n Universal Type Client and Core Client are now completely 64-bit.
n Universal Type Server no longer requires serial numbers for licensing the server and components;

instead, you enter the Extensis account credentials (email address and password) of the
software’s License Administrator.

n Universal Type Server includes in-app messaging to provide important product information to the
Server Administrator.

Version 7.0.1
n Font Usage by User report: This new report provides administrators with a snapshot of a user’s

current font usage.

Version 7.0.0
The big news in Universal Type Server 7 is the completely new Management application for managing
users, workgroups, and fonts. This application uses modern Web technologies (and eliminates Adobe
Flash) to provide an experience that is easier to navigate, fast, streamlined, and secure.

This release also includes:
n Auto-activation plug-ins for Adobe CC 2019.
n Improved security between Universal Type Client and Universal Type Server.
n Bug fixes.

System requirements
For the most up-to-date information about the latest release of Universal Type Server, please visit
Universal Type Server System Requirements.

Macintosh Server
n macOS™ 10.12 through 10.14
n 2.0 GHz or faster processor
n 4 GB RAM (8 GB recommended)
n 2 GB available hard drive space for application files, plus additional space for fonts

Windows Server
NOTE: Universal Type Server 7 requires a 64-bit version of Windows.

n Windows® Server 2012 R2, Windows Server 2016, or Windows Server 2019
n 2.0 GHz or faster multi-core processor
n 4 GB RAM (8 GB recommended)
n 2 GB available hard drive space for application files, plus additional space for fonts

Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-
7/system-requirements

https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
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Enterprise Edition database requirements
Enterprise Edition users have the option of utilizing one of these external databases. Use of an external
database is requiredwith a proxy failover configuration.

n PostgreSQL version 12.2 or 12.3 (macOS or Windows)
n (Deprecated) Microsoft SQL Server 2012 or 2016 (Windows)
n (Deprecated) MySQL 5.5, 5.6, or 5.7 (macOS or Windows)

IMPORTANT: Support for Microsoft SQL Server and MySQL has been discontinued. While we support
these external databases in the current release of Universal Type Server, they will be dropped in a
future release. Tomigrate to a supported database, please seeConverting between database
types on page 39.

Macintosh Universal Type Client
n macOS 10.11 through 10.15 and macOS 11
n 2.0 GHz or faster Intel processor

(Universal Type Client runs on Apple M1 systems using Rosetta 2 emulation.)
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Safari® 9 or later or the current release of Firefox® or Chrome™ to

view Help

Windows Universal Type Client
n Windows 7, Windows 8.1, or Windows 10

(64-bit only)
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Internet Explorer® 11, Microsoft Edge, or the current release of Firefox

or Chrome to view Help

Server Administration and User Management
Requirements for any computers that will be used for Server Administration or User Management. These
applications can be run remotely.

n Microsoft Edge (for administering the server fromWindows), Safari 11 or later (for administering
the server from a Macintosh), or the current release of Firefox or Chrome.

n An Internet connection and one of the above browsers to view Help.

Reports
Reports can be viewed from any supported desktop browser.

n Microsoft Edge (for viewing reports fromWindows 10), or
n Safari 11 or later (for viewing reports frommacOS), or
n The current release of Firefox, or
n The current release of Chrome.

Reports can also be viewed from a tablet on the same network as the Universal Type Server. Minimum
requirements are:

n iOS 11 or later, Android™ 9.0 or later, or Windows 10 version 1803 or later, and
n 1024×768 or larger display.
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Installation overview
The following is a general overview of the steps required to install and configure Universal Type Server.
1. Verify server system requirements.

Make sure your server meets or exceeds the specifications found at Universal Type Server System
Requirements.

2. Run the installer on the target server computer.
You can download the latest version of the installer from Universal Type Server Support. For
detailed installation instructions, see Installing Universal Type Server on the next page.
Note that you do not need to install the software on the server’s boot partition.

3. Activate your Universal Type Server license.
To do this, use the Management application. It should start automatically after you install
Universal Type Server.
To start the Management application manually, open a web browser on the Type Server system
and enter localhost:8080 in the address bar.
(If you are using a computer other than the Type Server system, you can launch the Management
application using the Type Server’s IP address and port 8080; for example, 123.45.67.89:8080.)
To activate the Type Server license:
a. Enter the administration username and password. The default Server Administrator

username and password are administrator and password.
b. Click the Administration tab, then click Licenses.
c. Click Activate Universal Type Server.
d. In the Login dialog, enter the email and password of your License Administrator, then click

Submit.
If your organization has multiple licenses with the same License Administrator, choose the
desired license and click Select.

For more information, see the documentation for Universal Type Server Management.
4. Log in to the Server Administration application.

a. Open a web browser on the Type Server system and enter the address localhost:18081.
On another system, you can access the Administration application using the Type Server’s
IP address and port 18081; for example, 123.45.67.89:18081.

b. Enter the administration username and password.
The default username and password are administrator and password.

5. Set the Bonjour Name (optional).
Bonjour makes it easy for users to find your Type Server. See Setting the Bonjour name on
page 23.

6. Check for and resolve port conflicts.
Universal Type Server requires several open ports for communication; if any of these are in use by
other software then youwill need to change them. See Resolving port conflicts on page 18.

7. Set any desired server configuration options.
This could include:
n Defining a Backup Plan (see Defining a backup plan on page 29);
n Configuring Log Files (see Log files on page 14);
n Implementing a Secure Connection (see Implementing a secure connection on page 19);
n Any other necessary server settings.

Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-
7/system-requirements

Universal Type Server Support: https://www.extensis.com/support/universal-type-server-7

https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7
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After installing the server, open the User Management application. From here, you can configure
workgroups and roles, then add users. These topics are covered in the User Management Guide and help
system.

Installing Universal Type Server
Before installation, ensure that your server meets all of the minimum system requirements.

Copy the installer onto the server’s hard disk, double-click to launch the installer and follow the
instructions.

For any late-breaking changes to the product, see Universal Type Server Release Notes.

After the installer runs, the installation application starts your web browser and opens the Server
Administration application.

NOTE: You can administer the server using a web browser on a remote computer. Enter the server’s
IP Address into your browser’s address field followed by a colon and the port number 18081. If this
port is already in use on your server, a random port is assigned. To obtain the port number, use the
command line tool; see Viewing server settings with the command line tool on page 60.

In the Server Administration application, log in using the default Server Administrator username and
password:

Server Administrator username: administrator
Server Administrator password: password

You should change the password in the User Management application before adding any other users to
the Type Server.

Uninstalling Universal Type Server
Removing Universal Type Server removes all of the Type Server application files, but leaves your font
repository and any backup files on the server.

To remove the Universal Type Server application on macOS:
1. In the Finder, navigate to Applications/Extensis/Universal Type Server/applications/.
2. Double-click the Uninstall Universal Type Server application icon and follow the instructions.
3. To remove the font repository and backup files from the default install location, move all files in

the Applications/Universal Type Server/ folder to the Trash.

To remove the Universal Type Server application on Windows Server:
1. Choose Start > Control Panel.
2. Click Programs, then click Programs and Features.
3. Select Universal Type Server.
4. Click Uninstall.
5. To remove the font repository and backup files from the default installation location, delete all

files from the directory Program Files/Extensis/Universal Type Server/.

NOTE: Your font repository and backup files may be in a custom location. You can delete these files if
you no longer need them.

Universal Type Server Release Notes: https://www.extensis.com/support/universal-type-server-7/release-
notes

https://www.extensis.com/support/universal-type-server-7/release-notes
https://www.extensis.com/support/universal-type-server-7/release-notes
https://www.extensis.com/support/universal-type-server-7/release-notes
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Upgrading from a previous version
IMPORTANT:

n When you perform an in-place upgrade of Universal Type Server, the installer will replace files
you have modified to enable SSL and create an HTTP redirect.
Before beginning the upgrade, you should save a copy of the uts.keystore file and copy
down the keystone-password information from the standalone.xml file.
Use that information to follow the directions at Implementing a secure connection on
page 19 to re-enable SSL and your HTTP re-direct.

n Please run a complete backup before attempting your upgrade.
Users of Universal Type Server 6 can upgrade directly to version 7. Users of earlier versions
must upgrade to version 6 first.
Universal Type Server 6 downloads are available here:
Universal Type Server 6 for Windows
Universal Type Server 6 for Mac

n The following procedure is appropriate for users who are currently using the embedded
Universal Type Server database. If you are upgrading to an external SQL database, read the
external database configuration instructions for Converting between database types on
page 39.

Create a backup file
Before you begin the upgrade process, it is essential that you create a backup file of your current
installation.

Newer versions of Universal Type Server use an upgraded database, so if you ever want to downgrade
Type Server to a previous version, this backup is required to complete the process.

Also, if you are moving to an external database, this backup file is used during the upgrade process.

To backup your current Universal Type Server to your current backup location:
1. Open your web browser and start the Server Administration application.
2. Under Datastore on the left, click Backups.
3. Note your current backup location, and click Backup now.

Install Universal Type Server
The Universal Type Server installer automatically removes your previously installed server, while keeping
all of your fonts, users and data intact.
1. Copy the new Universal Type Server installer to your server and double-click to run.
2. Follow the prompts to install the server upgrade.

NOTES
n During the upgrade process, all users will be disconnected and the server will be placed in

Standby mode. After upgrading the server, change the Access State to Normal. Users will need
to log in to the Type Server again.

n The database upgrade might take some time to finish. When complete, the server
automatically starts and is ready for users to connect.

After the installation is complete, activate your software.

Universal Type Server 6 for Windows: https://bin.extensis.com/UTS-6-1-7-W.zip
Universal Type Server 6 for Mac: https://bin.extensis.com/UTS-6-1-7-M.zip

https://bin.extensis.com/UTS-6-1-7-W.zip
https://bin.extensis.com/UTS-6-1-7-M.zip
https://bin.extensis.com/UTS-6-1-7-W.zip
https://bin.extensis.com/UTS-6-1-7-M.zip
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If you are upgrading from Universal Type Server 7.0 or 7.0.1:
Your existing license will work without any additional activations required. However, if you add features
(such as additional client connections or FontLink for InDesign Server), youwill need to deactivate then
reactivate your license. See the Universal Type Server Management documentation for details.

If you are upgrading from Universal Type Server 6.x:
Universal Type Server 7.0.2 and later does not require a serial number. Instead, the software makes a
one-time connection to Extensis to activate your license on your system.

Youwill need the email address and password of your License Administrator (typically, the person who
registered your license for Universal Type Server).

To activate your new license:
1. Start the Management application and log in.
2. Click the Administration tab, then click Licenses.
3. Click Activate Universal Type Server.
4. In the Login dialog, enter the email and password of your License Administrator and click Submit.

You are now ready to configure an external database and connect to Directory Services as required.

Deploy new Universal Type Client
The new version of Universal Type Server includes a new version of Universal Type Client. If you have
deployed Universal Type Client 6, you can allow your users to continue with this version. However, many
new features and performance enhancements will not be available if you do not upgrade users to the
latest client.

If you are still using Universal Type Client 5, youmust update users to a newer version; we recommend
updating to the latest version of Universal Type Client 7.

You do not need to upgrade users all at once, but we strongly recommend that you upgrade users to the
latest Universal Type Client at your earliest convenience.
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Server status
Opening the Server Administration
application
The Server Administration application is where the Server Administrator is able to:

n start, stop, and pause the server;
n change the server’s Bonjour name;
n examine and change port settings;
n manage memory allocation;
n view connected clients;
n configure and restore backups;
n locate, move, or create a new datastore;

To log in to the Server Administration application:
1. Open a supported web browser.
2. In the address field, enter your server IP address followed by a colon and the port number. The

default server administration port is 18081 (also called the Web Admin port). For example:
http://192.168.0.1:18081 or http://localhost:18081.

3. Enter the administration username and password. The default Server Administrator username
and password are administrator and password.

NOTES
n The Password field is case-sensitive, but the Username field is not.
n It is very important to change the Server Administrator password as soon after installation as

possible.
n The default location of the User Management application is the same IP address, with the port

number 8080. For example: http://localhost:8080
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Log files
The Universal Type Server creates log files to help identify and troubleshoot potential issues with the
server.

These files include records of the following transactions, as well as other information:
n User login and logout
n The IP addresses of connected users
n The addition and deletion of workgroups
n The addition and deletion of users
n Server startup
n Server shut down
n Database backup, restoration, and changes to backup settings
n Database deletion
n Changes in database location
n Changes in log file location

On Windows, the default location for log files is:
Program Files\Extensis\Universal Type Server\Logs

On macOS, the default location for log files is:
Applications/Extensis/Universal Type Server/Logs

These are the logs that are important for server administration:

LOG FILE NAME PURPOSE

extensis.admin.log Contains all log messages displayed in the Server Activity window of
the Server Administration Status page.

extensis.server.log This is the main server log. Changing the server logging level affects
what is recorded in this file.

server.log Contains very verbose logging of server activity.

boot.log This log is created by JBoss upon startup. If JBoss is having
problems at launch time, this file can provide useful diagnostic
information.
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Changing the logging level
The contents of the main Universal Type Server log file, extensis.server.log, can be updated based on
how much detail that you need.

The logging levels available are:

LOG LEVEL WHAT GETS LOGGED

ERROR Displays only error messages.

WARN Displays only error and warning messages.

INFO This is the default logging level and includes a wide variety of
information about server activity. This level is recommended for most
installations.

DEBUG This level of logging includes very detailed information about your
server and can result in very large log files. It is not recommended
unless specifically requested by your support representative.

To change the server logging level:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Click Logging.
3. Choose a new level from the Logging level drop-down menu, then click Update Server.

Changing the log location
Administrators can change the location where the main Universal Type Server log file,
extensis.server.log, is placed.

To change the log file location:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Click Logging.
3. Enter a new log location into the Logging directory field. The default location is in the logs folder

of the Universal Type Server application folder. The following are examples of new paths:
Windows: C:\Universal Type Server\logs
Macintosh: /Volumes/Macintosh HD/logs

NOTE: The new logging directory folder must already exist on the disk. Creating log files on a
network location is not supported. Enter the full path, do not use relative paths, and include a
drive letter on Windows.

4. Click Update server.

A new extensis.server.log file is created in the new location. The log file in the previous location is not
removed, but it is no longer updated.

All other Universal Type Server log files always remain in the default location, and the location cannot be
changed. If removed, they are automatically recreated by the server.
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Changing log backups
The extensis.server.log file is backed up on a daily basis at 12:15 a.m. to your designated logging
location. Log backup files are named with the log file name followed by the date of the backup, and
they can be opened with any text editor or word processor.

Since these files can become very large, youmay not want to keep a significant number of them on the
server. By default, the server keeps the 10 most recent log files.

To update the number of log backups to keep:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Click Logging.
3. Enter the number of backups to keep in the Retained server logs field and click Update server.

Ports
The Universal Type Server requires a number of ports on your server. These ports are used for client
connection, server administration as well as internal server communication.

Port Default

UTS HTTP / Web Service 8080

UTS HTTPS / Web Service 8443

UTSCLI 9999

Web Admin HTTP 18081

Web Admin CLI 19999

Report Service 8880

All ports used with Universal Type Server must not conflict with other applications on the server.

External ports must be opened in the host system’s firewall and operating system. The process of
opening ports varies by operating system. Please refer to the macOS and Microsoft Windows
documentation for more information.

NOTE: The Report Service port is not included in the Server Administration application’s Ports page. If
you have a conflict with the default port, contact Extensis Technical Support for assistance. (See
Support on page 73).
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Ports for external communication
The Universal Type Server requires three ports to be open for server administration and client
connection.

Port Default

UTS HTTP / Web Service 8080

UTS HTTPS / Web Service 8443

Web Admin HTTP 18081

These ports are used on a regular basis and are listed on the Server Administration Ports page.

IMPORTANT: If you are configuring a Primary and Secondary server in a failover configuration, be
sure the ports are set to the same values on both systems. SeeConfiguring automatic failover
services on page 41 for more information.

UTS HTTP/Web Service port
This is the port where users connect to your server, as well as the port where administrators open the
User Management application. The default port setting is 8080.
Client connections
Clients require the following information for server login:

n The server IP address, DNS name or Bonjour name.
n The UTS HTTP / Web Service port number. If using a Bonjour name, a port is not required.
n Client account name and password.

User Management
To connect to the User Management application, enter the server IP address in the address field of any
supported browser followed by a colon and the port number.

For example: http://123.45.34.12:8080/

UTS HTTPS/Web Service port
When the secure connection option is enabled, administrators connect to the User Management
application through the UTS HTTPS/Web Service Port.

The default setting for this port is 8443.

The port for secure connections is only used to connect with the User Management application. With
secure connections enabled, when administrators attempt to connect with the UTS HTTP/Web Service
port, they are automatically redirected to the UTS HTTPS/Web Service port.

For example, an administrator can enter http://123.45.34.12:8080 and be redirected to
https://123.45.34.12:8443, or enter https://123.45.34.12:8443 directly.

Web Admin port
This port is used to open the Server Administration application. Enter the server IP address followed by a
colon and the port number in the address field of a supported web browser. The default port setting is
18081.

Example: http://123.45.34.12:18081/
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Ports for internal server communication
A number of standard Java J2EE and web service ports must be reserved for the internal communication
of Universal Type Server.

It is possible that youmay have other applications running or requiring Java on your server. Type Server
runs a self-contained version of Java, so it is possible to run other Java and web service applications on
the same computer, provided that you resolve any port conflicts.

To avoid conflicts, use the Ports page to assign new port numbers for Type Server.

The following ports are required for internal Universal Type Server communication:

Port Default

UTSCLI 9999

Report Service 8880

NOTE: The Report Service port is not included in the Server Administration application’s Ports page. If
you have a conflict with the default port, contact Extensis Technical Support for assistance. (See
Support on page 73).

Resolving port conflicts
The Universal Type Server installer checks to see if the default server administration port 18081 (Web
Admin Port) is bound to any other application. If it is already taken, then another port is chosen
randomly before the Server Administration application starts.

All other ports listed on the Server Administration’s Ports page are required for proper operation of the
server. Type Server checks for any port conflicts and lists them in the extensis.admin.log. The server
uses standard JBoss ports, so if your server has other applications that are built using this technology,
youmay need to change the default Type Server port numbers.

NOTE: The Report Service port (default 8880) does not have an entry on the Ports page. If you have a
conflict and need to change this port’s value, contact Extensis Technical Support (see Support on
page 73).

To update port numbers:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Under Settings on the left, click Ports.
3. For each port that requires a new port number, enter a new port number or click Find port to

locate an open port.
4. Click Update Ports.
5. Restart the server (see Stopping, starting, and restarting the server on page 23).
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Opening ports in the Windows firewall
To open ports for server administration and client connection:
1. Open the Windows Control Panel.
2. Double click theWindows Firewall icon.
3. Click theChange Settings option.
4. If prompted, click Continue to allow this action.
5. Click the Exceptions tab of theWindows Firewall Settings dialog, then click Add Port.
6. In the Add A Port dialog, enter the following information and click OK.

n Name: Universal Type Server User Management
n Port: 8080
n Protocol: TCP

7. Click Add Port again to add a second port. Enter the following information and click OK.
n Name: Universal Type Server System Administration
n Port: 18081
n Protocol: TCP

8. Click OK to accept the new settings.

Security concerns
The Universal Type Core communicates with the Type Server using HTTP through the JBoss HTTP port
(see Ports for external communication on page 17).

All client and server login usernames are sent as clear text via HTTP. For security reasons, all associated
passwords are encrypted and sent using the MD5 cryptographic hash function.

For additional security, Extensis recommends that the Type Server run behind a firewall using
authentication through the required external ports (see Ports for external communication on page 17).

Implementing a secure connection
A secure connection provides encrypted communications between Universal Type Server and the
computer that is used to administer the server.

A redirect to the secure connection port is not enabled by default. A secure connection can be enabled
using the default, self-signed certificate, or with a custom security certificate for your organization.

NOTE: Enabling a secure connection will cause a slight performance degradation in the User
Management application. This setting does not affect your client users in any way.

Enabling a secure connection requires the following steps:
1. Obtain a custom security certificate.
2. Edit two separate files named standalone.xml to add your security certificate and password.
3. Enable the automatic redirect to the secure connection by editing the web.xml file.
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Obtain a security certificate
Security certificates tell the web user that the secure connection is valid and can be trusted. Typically
these certificates are issued by trusted organizations. If desired, obtain a security certificate for your
organization.

Universal Type Server includes a default, self-signed security certificate. This certificate allows you to
create a secure connection without obtaining your own custom certificate. Using the default certificate
will cause your browser to display a number of security warnings when you open the User Management
application. These warnings indicate the nature of the self-signed certificate, but by using it you can
still create a secure connection with the Type Server. All browsers allow you to record a security
exception or to trust the self-signed certificate. See your browser’s documentation for details.

If you choose to obtain a custom security certificate, you can obtain a one from Verisign, GoDaddy, or
other Certificate Authority.

After obtaining the certificate, rename the file to uts.keystore and use it to replace the default
certificate in the following location on your server:

Windows: C:\Program Files\Extensis\Universal Type
Server\applications\jboss\standalone\configuration\uts.keystore

Macintosh: /Applications/Extensis/Universal Type
Server/applications/jboss/standalone/configuration/uts.keystore

Verisign: https://www.verisign.com/ssl/
GoDaddy: https://www.godaddy.com/ssl/ssl-certificates.aspx

https://www.verisign.com/ssl/
https://www.godaddy.com/ssl/ssl-certificates.aspx
https://www.verisign.com/ssl/
https://www.godaddy.com/ssl/ssl-certificates.aspx


- 21 -

Edit the files named standalone.xml
You enable the secure connection by adding the name, location, and password for your security
certificate in two files named standalone.xml.

To add the security certificate:
1. Open the first standalone.xml file from the following location with a text editor such as Notepad

or TextEdit.
Windows: C:\Program Files\Extensis\Universal Type

Server\applications\jboss\standalone\configuration\standalone.xml
Macintosh: /Applications/Extensis/Universal Type

Server/applications/jboss/standalone/configuration/standalone.xml
2. To change the name and location of your security certificate, search for the certificate-key-

file value. Edit the value between the quote marks tomatch your security certificate file name. If
you renamed your security certificate to the default name, uts.keystore, and placed it in the
default location, you can leave this value as is.
For example, the default entry in standalone.xml looks like this: certificate-key-
file="${jboss.server.base.dir}/configuration/uts.keystore"
If you have moved the security certificate file, enter its complete path between the quote marks.
Windows example: certificate-key-file="C:\Users\me\certificates\my_uts_

cert.keystore"
Macintosh example: certificate-key-file="/Users/me/Documents/my_uts_

certificate.keystore"
3. To enter the password of your security certificate, search for the password entry. Edit the value

between the quote marks tomatch your security certificate password.
password="uts_ssl"

4. Save and close the standalone.xml file.

Repeat the above steps for the second file named standalone.xml, found at the following location:
Windows: C:\Program Files\Extensis\Universal Type

Server\applications\jboss\analytics\configuration\standalone.xml
Macintosh: /Applications/Extensis/Universal Type

Server/applications/jboss/analytics/configuration/standalone.xml

Enable a redirect to the secure port
Editing the web.xml file enables a redirect from the standard web service port (default port 8080) to the
secure connection port (default port setting 8443).

To enable the redirect:
1. Open the file from the following location with a text editor such as Notepad or TextEdit.

Windows: C:\Program Files\Extensis\Universal Type
Server\applications\jboss\standalone\deployments\uts.ear\uts.war\WEB-
INF\web.xml

Macintosh: /Applications/Extensis/Universal Type
Server/applications/jboss/standalone/deployments/uts.ear/uts.war/WEB-
INF/web.xml

2. Use the search feature to locate the line that contains the transport-guarantee parameter.
Change the following line from:
<transport-guarantee>NONE</transport-guarantee>

to:
<transport-guarantee>CONFIDENTIAL</transport-guarantee>

3. Save and close the web.xml file.
4. Youwill need to restart your Universal Type Server for the change to take affect.
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Automatically starting the server
If you need to restart the physical server, the Autostart preference must be enabled for the server to
automatically launch and serve fonts to clients.

The Autostart preference is enabled by default, but may be disabled if desired depending upon your
server configuration.

To enable the Autostart preference:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Click System.
3. Choose Autostart > Enabled.
4. Click Update server.

If the Autostart preference is disabled, administrators are still able to connect to the Server
Administration application to start the server.

Placing the server in standby mode
Placing the server in standby mode prevents any non-administrative users from performing any actions
that require communication with the Universal Type Server. The server runs normally for administrative
users.

When in Standby Mode, all client users are not logged off, but are placed in offline mode. While in offline
mode, users are only able to activate and preview files that are in their local cache. Font files that are
not available for user are displayed in red in the Universal Type Client.

When performing datastore backups and restores, the Type Server automatically changes to standby
mode before performing the required administrative task, and then changes back to normal mode when
the task is complete.

To place the server in standby mode:
1. Notify users of your intention to place the server in standby mode.
2. Open your web browser and start the Server Administration application.
3. Click System.
4. Choose Access state > standby.
5. Click Update server.

The server will be placed in standby mode.
6. Perform any necessary server maintenance.
7. Click System.
8. Choose Access state > normal.
9. Click Update server.

The server resumes normal access and displays the Status page when complete.
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Stopping, starting, and restarting the
server
If you need to stop, start, or restart Universal Type Server, use the Server Administration application. This
ensures that all processes are properly shut down and restarted.

When you shut down the server, connected clients are automatically put in Offline mode. This means
that client computers will only have access to fonts that are cached locally on their computer. Which
fonts are cached depends mostly upon the font replication mode that is enabled for each user. See the
User Management Guide for more information.

Before you shut down or restart your Type Server, we recommend that you notify users so they can
prepare to work offline.

To stop Universal Type Server:
1. Start your web browser and connect to the Server Administration application (seeOpening the

Server Administration application on page 13).
2. Under Settings on the left, click System.
3. Choose Running state > stopped.
4. Click Update server.

When the server has stopped, the Status page will be displayed.

To start the server:
1. Start your web browser and connect to the Server Administration application.
2. Click System again.
3. Choose Running state > started.
4. Click Update server.

When the server has finished starting, the Status page will be displayed.

To restart the server:
n Follow the steps above to stop the server, then follow the steps to start the server. Be sure the

Status page shows the server has stopped before attempting to start it.

Starting automatically
If you need to restart the physical server hardware, you should enable the Autostart preference (see
Automatically starting the server on the previous page) for the Type Server to automatically launch
and serve fonts to clients. If this preference is disabled, youwill need to start the Type Server manually.

Setting the Bonjour name
Bonjour is a technology from Apple Inc. that enables users to easily locate Universal Type Server on the
network. Bonjour technology is built intomacOS, and is installed by the Universal Type Client installer
for clients using Microsoft Windows.

When users connect to the server, they only need to know the server’s Bonjour name, their username,
and their password to connect.
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To set the Universal Type Server Bonjour name:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. Click System.
3. Enter a Bonjour Name into the field. If you have more than one Type Server, choose as specific a

name as possible.
4. Click Update server.
5. Restart the server (see Stopping, starting, and restarting the server on the previous page).

To test the new Bonjour name:
1. Launch the Universal Type Client.
2. If the client is currently connected to a server, choose File > Server > Forget Connection.
3. In theConnect to Server dialog, choose Server > Browse Local Servers.
4. Select your new Bonjour name from the list and click OK.
5. Enter your username and password and click Connect.

Memory allocation
If you are using Universal Type Server with a large number of LDAP users or a large number of
workgroups, youmay find it necessary to increase the amount of memory available to the Type Server.
This is especially important if your server logs have Java Heap Space errors.

To change the server memory allocation:
1. Click System.
2. Enter the amount of memory for the Java Virtual Machine in theMemory Allocation field.

IMPORTANT: Select a size that is lower than the amount of physical memory in the server system.
For example, if your server has 8GB of RAM, do not attempt to allocate more than 6GB to the
Type Server.

3. Click Update server.

The Universal Type Server will restart.

Locking Server Administration
The Server Administration application automatically logs you out after a period of inactivity. Sometimes
youmay want to continually monitor the server status, and not automatically be logged out. For
example, youmight want to keep the Status page displayed on a server roommonitor.

Locking the status page does not prevent other users from accessing the Server Administration
application from another computer.

To lock the Server Administration Status page:
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. In the Status area, click the Lock icon.

To unlock the server, click the lock icon and log in.
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Client connections
Viewing connected users
Administrators can view a high level list of connected users in the Users page of the Server
Administration application. This list provides the login User Name, Full Name, IP Address, and Login Date.

You can sort the list of users by any field by clicking the sort icon at the top of each column.

If you are using both traditional Type Client and Core Client connections in your configuration, users
can be filtered by client type. Choose:

n User Type > All to display both Type Client and Core Client conenctions.
n User Type > Full to display only Type Client connections.
n User Type > CoreClient to display only Core Client connections.

To update the number of connected users visible at a time, enter a new number in the Users per page
field and click Update page size.

For more complete user management, including adding and removing users, open the User Management
application.

Forcing user disconnection
In some instances, youmay need to force the logout of a currently connected user.

For example, if you are currently using all of your license seats, youmay need to force the logout of one
user to allow another user to connect. In another instance, youmay need to force the logout of a
recently terminated employee. Youwould of course also want to delete the user account of any
terminated employee using the User Management application.

To force user logout:
1. Open your web browser and start the Server Administration application.
2. Click Usersin the menu at the left.
3. Check the boxes for the users that youwant to disconnect. To select all users on the current page,

check the box at the top of the first column.
4. Click Force Logout Selected Users.

When you force the logout of a user, it is the same as the user selecting Server > Forget Connection.
After forcing the logout of a user, the next time the client attempts to synchronize with the server the
connection is terminated and all server fonts are removed from the client.
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Datastore
Creating a new datastore
IMPORTANT: When you create a new datastore, your current datastore will be deleted. Youmay
wish to back up your existing datastore and move it to a safe location before you create a new one.
For instructions, see Backing up the datastore on page 29.

The datastore consists of two parts: the database and the vault. The database location is fixed (whether
you are using a native database or a SQL-based external database), but the vault can be moved to a
new location.

The default location for the vault depends on your operating system:
n Windows: C:\Program Files\Extensis\Universal Type Server\data\vault
n macOS: /Applications/Extensis/Universal Type Server/data/vault

For details about specifying a new vault location, see Vault location requirements on the next page.

To create a new datastore:
1. Log in to the Server Admin application.
2. ClickMove/New under Datastore in the navigation menu on the left.
3. Enter the full path where youwant to create a new vault in the field labeled New repository

location.
Universal Type Server will create any folders that don’t already exist.
NOTE: The database component of the datastore is always in the same location, regardless of
whether you are using the built-in database or a SQL-based solution.

4. Click New datastore.
5. Click OK to confirm.

The Type Server will go in to standby mode, then it will automatically start when the operation is
complete.

After creating a new datastore, youwill need to go through all of the standard configuration steps,
including creating workgroups and users.

IMPORTANT: If you create a new vault on a network share, that share must be accessible in
read/write mode to the account that your Type Server runs under. For Universal Type Server
installations on Windows, the share must be specified with a UNC path, and the Type Server must be
running under a domain user account with full read/write access to the share. For Universal Type
Server running on macOS, the share must be specified as a POSIX path.
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Moving the vault
The vault is the part of Universal Type Server’s datastore that holds all the fonts hosted by your Universal
Type Server. Because it stores a copy of each unique font, your vault can become very large.

The vault is initially created on the same volume where you installed Universal Type Server. If you think
that your vault will need more space, you can move it to a new drive.

Moving the vault can take several minutes, depending on how big it is. You should move it when users
don’t need to access your Universal Type Server.

Vault location requirements
The new location for the vault must:

n Be specified by the full path to the vault folder (not a relative path such as ..\path_to_vault);
n Always be accessible to the Universal Type Server;
n Grant read/write access to the computer account under which Type Server runs;
n Be specified by a UNC path (Windows) or a POSIX path (macOS) if it is on a network volume.

You should use a folder dedicated to the vault, because Universal Type Server will create several folders
inside it. We suggest naming the vault folder “vault.”

Be aware that if you locate your vault in a folder that others use, anyone that has access to that folder
may inadvertently corrupt the vault’s contents.

IMPORTANT:
n You should only move your vault to a network location if you are using a failover configuration

(seeConfiguring automatic failover services on page 41).
n You should not move your vault to a local volume that is removable (such as an external USB

drive).

Windows vault path examples
C:\Users\jsmith\documents\vault\
D:\shared_files\font_vault\

D: is a local drive
\\NetworkFiles\Design\vault\

NetworkFiles is the server name, Design is a shared volume on the server, and vault is the vault
folder

Mac vault path examples
/Users/jdoakes/font vault

Universal Type Server should be running under the jdoakes login account)
/Volumes/Marketing/misc/vault

Marketing is a shared network volume, misc is a folder on the volume, and vault is the vault
folder)

If you are running Universal Type Server on Windows:
n If you are using a network volume to store your vault, do not use a mapped drive path (such as

Z:\path_to_vault) as the path you enter in Universal Type Server. Instead, use the complete UNC
path (such as \\remote_server\shared_volume_name\path_to_vault).

n Universal Type Server must be running under a domain user account that has full read/write
access to the network vault location.

n If your vault is located on a macOS system, be sure to enable Windows (SMB) sharing for the vault.
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If you are running Universal Type Server on macOS:
n If you are using a network volume to store your vault, enter the POSIX path to your vault (such as

/Volumes/shared_volume_name/path_to_vault) in Universal Type Server.
n If youmount more than one network volume with the same name as the volume that your vault is

on (shared_volume_name in the example above), be aware that the order in which the volumes are
mounted may make it impossible for Universal Type Server to find your vault. To be safe, only
mount volumes with unique names. If youmust mount network volumes that have identical names,
be sure to always mount your vault’s volume first.

Tomove your vault to a new location:
1. Log in to the Server Admin application.
2. ClickMove/New under Datastore in the navigation menu on the left.
3. Enter the full path where youwant tomove the vault in the field labeled New location for vault.

Universal Type Server will create any folders that don’t already exist.
4. ClickMove vault.

The Type Server will go in to standby mode, then it will automatically start when the operation is
complete.
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Backing up and restoring
Defining a backup plan
As you set up Universal Type Server, it is important to define an effective datastore backup plan. This
ensures that, in cases of emergency, your datastore is safe and can be restored.

The Universal Type Server datastore contains all of the fonts, as well as all user, workgroup, and server
data. Backup files are rolled into a single, date-stamped .TAR file. TAR files are archive files like the
ZIP files created by your operating system.

It is recommended that you back up your datastore at least once per week. Plan to store copies of the
backup in an offsite location from time to time. This ensures that if anything happens to the local copies
of the files, you can restore from the offsite backup.

For the highest level of data security, it is best to keep multiple backup files. Universal Type Server is able
to automatically create and retain however many backup files that you need, and subsequently remove
any out-of-date backups.

Backups can be performed manually, but it is much easier to define a schedule and allow Universal Type
Server to automatically create files.

IMPORTANT: Backups must be created in an existing folder location on the Universal Type Server
computer. Backing up the server to network locations, including NFS-mounted or UNC accessible
paths, is not supported.

In case of any hardware failure or other incident, a backup can be easily restored to a new server install
location using the Server Administration application.

Backing up the datastore
While you can back up Universal Type Server’s data using other software, we recommend that you use
the built-in backup utility. This allows you to quickly restore or replicate an entire Universal Type Server
database, including all fonts and user information, on a new system if you need to.

You can back up the server manually or configure Universal Type Server to perform automatic backups at
regular intervals.

Tomanually back up the datastore:
1. Open your web browser and start the Universal Type Server Administration application.
2. Under Datastore in the menu on the left, click Schedule backups.
3. Enter a local backup destination into the Backup destination field.

The default location for the datastore is the data\backups folder of the Universal Type Server
application folder.
Enter the full path; do not use relative paths, and be sure to include a drive letter on Windows.
The following are examples of appropriate paths:
Windows: C:\Universal Type Server\backups
Macintosh: /Volumes/Macintosh HD/backups

4. Click Update server.
5. Under Datastore in the menu on the left, click Backups.
6. Click Backup now.
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To configure automatic backups:

NOTE: For automatic backups, it is best to set backup times when most users are not connected to
the server. When the server is performing a backup, users are not disconnected, but are unable to
synchronize with the server until after the backup is complete.

1. Open your web browser and start the Universal Type Server Administration application.
2. Under Datastore in the menu on the left, click Schedule backups.
3. Enter a local backup destination into the Backup destination field.

The default location for the datastore is the data\backups folder of the Universal Type Server
application folder.
Enter the full path; do not use relative paths, and include a drive letter on Windows.
The following are examples of appropriate new paths:
Windows: C:\Universal Type Server\backups
Macintosh: /Volumes/Macintosh HD/backups

4. Enter the number of backup files to retain in the Retained backups field.
For the highest level of data security, it is a good idea to keep multiple backups.

5. Choose the time and days for backing up that will cause the least amount of user disruption.
6. Click Update server.

After setting automatic backups, be sure tomake a note of the times when you should also be moving
backup files off the server to a secure, offsite location.

Restoring a backup
In the case of hardware failure or other issues, a backup datastore can be restored. The backup
contains all fonts, users, workgroups, and all other settings to restore your datastore to the backed-up
state.

IMPORTANT: Restoring a backup overwrites your current datastore. All connected users are
automatically logged out, and will need to reconnect.

To restore a backup:
1. Open your web browser and start the Server Administration application (seeOpening the Server

Administration application on page 13).
2. Under Datastore on the left, click Backups.
3. Enter the full path and filename of the backup file in the Restore field.

Enter the full path; do not use relative paths, and include a drive letter on Windows.
The following are examples of appropriate paths:
Windows: C:\Universal Type Server\backups\2008_02_18T10_00_00_156Z.tar
Macintosh: /Volumes/Macintosh HD/backups/2008_02_18T10_00_00_156Z.tar

4. Click Restore datastore.
5. Click OK to confirm the restore.
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Client administration
Most Universal Type Client information can be found in the Universal Type Client User Guide as well as
the Type Client help system.

It’s important to note that all font administration, including adding and removing fonts, is done directly
in the Universal Type Client.

Universal Type Client system requirements
For the most up-to-date information about the latest release of Universal Type Client, please visit
Universal Type Server System Requirements.

Macintosh Universal Type Client
n macOS™ 10.11 through 10.15
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Safari® 9 or later or the current release of Firefox® or Chrome™ to

view Help

Windows Universal Type Client
n Windows® 7, Windows 8.1, or Windows 10

(64-bit only)
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Internet Explorer® 10, Microsoft Edge, or the current release of Firefox

or Chrome to view Help

The Universal Type Client cache
Each client system stores fonts and other client data locally in a cache folder. This includes all
necessary server fonts as well as items in client-based personal workgroups.

When a user chooses Server > Forget Connection, any font files cached in the Type Client cache are no
longer available for use on that system.

If a user chooses Server > Go Offline, fonts are available depending on their font replication mode
setting.

n All: The user has access to all fonts in their workgroups.
n On-Demand Local Cache: The user has access to any fonts that they have previously used. Any

fonts that they have ever previewed or activated reside in the cache.
n On-Demand: The user has access to the fonts that are active on their system before going

offline.

Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-
7/system-requirements

https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
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The Type Client cache consists of two components, the database and the type cache:
n The type cache is the storehouse for all fonts downloaded from the server. The cache’s structure

varies by platform. For the macOS client, the UniversalType.typecache file is a bundle that
contains all fonts. On Windows, font files are stored within a directory named cache.

n UniversalType.db contains all of the database information, such as font and workgroup details
and client permissions. It is stored within the UniversalType.typecache bundle.

IMPORTANT: Deleting or moving any part of the client cache may render the application inoperable.
Contact Extensis Technical Support before attempting to alter the client cache in any way.

The Type Client cache files are stored in the following locations:

macOS: /Library/Extensis/UTC/<uid>/UniversalType.typecache/

The UserID (uid) is a unique number assigned by macOS to each user account. The first user account on
the computer is 501, followed by 502, 503, and so on. To determine the uid for the current user, open a
Terminal window and enter the id command.

Last login: Fri Mar 14 15:92:65 on console
user@typeclientsystem_1 ~ % id
uid=501(user) gid=20(staff) groups=20(staff),12(everyone),80(admin)
user@typeclientsystem_1 ~ %

Windows: C:\Users\<username>\AppData\Local\Extensis\UTC\cache\

To open this directory, pressWIN+X to open the systemmenu, click Search, type the environment
variable %LOCALAPPDATA%, then press ENTER.

Disabling other font managers
To ensure the proper operation of Universal Type Client, it is important to disable or uninstall any other
font managers.

Just closing or quitting other font managers might not be sufficient. Many font mangers, including the
Universal Type Client, run an application in the background that manages font activation and
deactivation. These background applications must be disabled before running the Type Client. To do so,
check for an application preference that tells the other application to open on startup or login and then
restart your computer.
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The Universal Type Core
The Universal Type Core is a background application that runs on the client computer. This application
handles all communication with the Type Server and makes it possible for the user to close the Universal
Type Client and still keep fonts active and automatically activate fonts. The Type Core handles all plug-
in based auto-activation requests and automatically implements any updated permissions, workgroup
changes, and all other changes upon synchronization with the server.

The Universal Type Core is started when the user logs in to their computer. You can stop the Type Core
from the Universal Type Client preferences.

To stop the Type Core:
1. Start the Universal Type Client.
2. Choose Universal Type Client > Preferences (Mac) or Edit > Preferences (Windows).
3. Click the FMCore tab in the Preferences dialog.
4. Click Stop FMCore.
5. When asked if you are sure, click Stop FMCore.

When you stop the Universal Type Core, font management is disabled, and all active fonts are
deactivated. Generally, the only fonts that will be available for use on the computer will be the fonts
protected by the operating system.

Client license management
You can see how many users are connected, the associated IP addresses, and unique computer
identification in the Users panel in the Server Administration application.

How client connections are counted
For environments where more than one user connects using the same computer, only one client license is
consumed. This allows an environment that may have many users on a computer during the course of
the day, such as educational institutions, to allow each user to connect, and even if each user does not
choose the Forget Connection command at the end of their session, the computer itself only consumes
one client license for the computer.

Conversely, if a user logs in to Universal Type Server from two separate computers, two client licenses are
required. For example, in an environment where every user has both a Mac and a PC, a client license is
required for each computer.

Automatic disconnection
Users whomay spend long amounts of time working offline away from the server must connect to the
server at least once every 30 days or be automatically disconnected from the server. Once
disconnected, the client license is freed and available for another user. The disconnected user is no
longer able to access fonts through the Universal Type Client, and must reconnect to Type Server to
regain access.

Client license overage
When the number of licensed clients is reached, any additional users who attempt to connect are not
able to do so. To forcibly disconnect a user tomake that connection available for another user, select the
user from the Users panel of the Server Administration application and click
Force Logout Selected Users.
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Enterprise features
The Enterprise version of Universal Type Server provides extended capabilities for organizations with
large font management and compliance needs. The additional and enhanced features available to
Enterprise users are:

n External SQL database connection
n Automatic Failover Services
n Font license compliance enforcement
n Font usage and compliance reporting

Font usage and licensing is managed through the User Management application.

Upgrading to Enterprise
When you are ready to upgrade from Universal Type Server Professional to Universal Type Server
Enterprise, you should back up your datastore.

Once your organization has purchased the Enterprise license, youwill need to deactivate then
reactivate your installation.
1. Open the Management application and log in.
2. Click the Administration tab, then click Licenses.
3. Click Remove, then click OK.
4. Click Activate Universal Type Server.
5. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.

External SQL database
Rather than store the Universal Type Server database in the native embedded database, Enterprise
users have the option to store all of the required data in an external SQL database. Youmay want to do
this if:

n Your company maintains a dedicated database server for data management and centralization
purposes.

n You need to take advantage of the additional administration and performance tuning options in
third-party SQL databases that are not available in the embedded Type Server database.

n You require a distribution of hardware resources to improve the performance and scalability of
your server.

After configuring the connection to an external database, most administrative functions, and all client-
level interaction with Universal Type Server function the same as the native, embedded Type Server
database.
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External database requirements
Universal Type Server Enterprise supports the following SQL database servers:

n PostgreSQL version 12.2 or 12.3 (macOS or Windows)
n (Deprecated) Microsoft SQL Server 2012 or 2016 (Windows)
n (Deprecated) MySQL 5.5, 5.6, or 5.7 (macOS or Windows)

IMPORTANT: Support for Microsoft SQL Server and MySQL is deprecated. While we support these
external databases in the current release of Universal Type Server, they will be dropped in a future
release. Tomigrate to a supported database, please seeConverting between database types on
page 39.

Hardware recommendations for an external SQL database
n For best performance, your database server should be configured on a separate server-grade

computer from your Universal Type Server.
n In general, faster processor cores, faster memory, a faster disk interface, faster hard disk, and

faster network connection will yield optimal performance.
n If possible, your database software and database should be installed on a separate physical disk

from the database server’s operating system.

Vendor recommendations
PostgreSQL

n PostgreSQL macOS support
n PostgreSQL Windows support

Microsoft
n Microsoft SQL Server 2012
n Microsoft SQL Server 2016

MySQL
MySQL does not publish specific system requirements for the database server.

Installing an external database
Install Universal Type Server
Before configuring the external database connection, install the Universal Type Server application, and
then proceed with the instructions below.

If you have previously installed and configured Universal Type Server, and prefer to upgrade your data,
follow the instructions for Converting between database types on page 39. There is no need to re-
install Universal Type Server.

PostgreSQL macOS support: https://www.postgresql.org/download/macosx/
PostgreSQL Windows support: https://www.postgresql.org/download/windows/
MS SQL Server 2012 system recommendations: https://docs.microsoft.com/en-us/previous-versions/sql/sql-

server-2012/ms143506(v=sql.110)
MS SQL Server 2016 system recommendations: https://docs.microsoft.com/en-us/sql/sql-

server/install/hardware-and-software-requirements-for-installing-sql-server?view=sql-server-2016

https://www.postgresql.org/download/macosx/
https://www.postgresql.org/download/windows/
https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/ms143506(v=sql.110)
https://docs.microsoft.com/en-us/sql/sql-server/install/hardware-and-software-requirements-for-installing-sql-server?view=sql-server-2016
https://www.postgresql.org/download/macosx/
https://www.postgresql.org/download/windows/
https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/ms143506(v=sql.110)
https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/ms143506(v=sql.110)
https://docs.microsoft.com/en-us/sql/sql-server/install/hardware-and-software-requirements-for-installing-sql-server?view=sql-server-2016
https://docs.microsoft.com/en-us/sql/sql-server/install/hardware-and-software-requirements-for-installing-sql-server?view=sql-server-2016
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Install the database server and create a database
1. Install the database server following the vendor’s instructions.

To get the benefits of an external database, we recommend installing your database server on a
separate system from Universal Type Server.

2. Using the database administration interface or command line tools provided by the database
server, create a user account that Universal Type Server will use to access the external database.
The account (or “login”) will include at least a username and a password.

3. Create a new empty SQL database for the Universal Type Server datastore. Set the new user
account as the database owner.

IMPORTANT: For PostgreSQL and MySQL, accept the default collation. For Microsoft SQL
Server, specify Latin1_General_BIN2 collation.

For step-by-step instructions to install PostgreSQL and create a database, see Setting up PostgreSQL
on the next page.

Open a port in the firewall
If you are using a firewall on the computer that hosts the SQL server, youmust open a port so that
Universal Type Server can connect to the SQL database.

The default ports used by supported external databases are:
n PostgreSQL: 5432
n Microsoft SQL Server: 1433
n MySQL: 3306

This port can be changed in your database server tomeet any specialized requirements.
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Connect Universal Type Server to the empty SQL database
1. Open the Server Administration application (seeOpening the Server Administration

application on page 13).
2. In the Datastore area, click Database.
3. Click the Database Type drop-down menu and select your database server type.
4. Enter the following fields so that Universal Type Server can connect to the new database server.

FIELD DESCRIPTION

Server Address Either the DNS name or IP address of the computer hosting the
database server.

Port The port used to access the external database server. Defaults:
n PostgreSQL: 5432
n Microsoft SQL Server: 1433
n MySQL: 3306

Database Name The name of the database that you created for Universal Type
Server.

Username The username that you created for Universal Type Server to use.
(The database software may refer to this as username, account, or
login.)

Password The password for the username above.

5. The Additional Parameters field is used tomodify the behavior of the connections between
Universal Type Server and Microsoft SQL Server. The use of this field is relatively rare. If required,
enter any parameters provided by your database administrator.

6. Click New datastore to create the new datastore. Youwill be prompted to delete the existing
datastore; click OK.

Verify database creation
After creating the new datastore, click Status in the Server Administration application. Check in the
Status window to verify that Universal Type Server has stopped and restarted. This is your indication
that the datastore has been created and the server is running. See External database error messages
on page 41 for solutions to common issues.

You can now administer the Universal Type Server the same as youwould with an embedded database.

Setting up PostgreSQL
Here is a quick walk-through of installing PostgreSQL on macOS and Windows Server systems, then
creating a user account and database for use by Universal Type Server.

The PostgreSQL administration application, pgAdmin, runs as a background application and uses your
default web browser to present the interface for managing PostgreSQL. If you are installing toWindows
Server, be sure to have a modern browser (Edge, Chrome, or Firefox) installed and configured as your
default browser.

Most of these instructions require administrator access. You should log in to the computer using an
account with administrator privileges.
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Install PostgreSQL
1. Download the latest version of the PostgreSQL installer for your platform from

https://www.enterprisedb.com/downloads/postgresql/.
2. On macOS, double-click the downloaded DMG file tomount a virtual disk on your desktop.

The disk image file is in your Downloads folder and is named postgresql-##.#-#-osx.dmg.
3. Double-click the installer icon.

On macOS, the installer is named postgresql-##.#-#-osx.app and is found in the mounted disk
image.
On Windows Server, the installer is named postgresql-##.#-#-windows-x64.exe and is found in
your Downloads folder.

4. Confirm that youwant to allow the installation to proceed.
On macOS, enter your computer password and click OK.
On Windows Server, click Yes.

5. The installer consists of a number of simple steps. Review the requirements in each step, then click
Next.
a. Setup:Click Next.
b. Installation Directory: Accept the default and click Next.

If you really need to change the installation directory, then make a note of it.
c. Select Components: The default is all components selected. Accept this and click Next.
d. Data Directory: Accept the default and click Next.

If you changed the Installation Directory, confirm that the Data Directory is correct, change
it as needed, then make a note of it.

e. Password: The PostgreSQL superuser login is postgres. Create a password for this account,
then retype it to confirm and click Next.
Make a note of this password!

f. Port: Accept the default port (5432), then click Next.
Make a note of the port number.

g. Advanced Options: Set the Locale for your installation of PostgreSQL. In most cases, you
can accept the default (Default Locale) and click Next.
The Default Locale is determined by your operating system. The Locale includes information
about alphabet, sorting, and number formatting preferences.

h. Summary: This shows all the options you have selected. Click Back if you need to change
any. When you’re ready to continue, click Next.

i. Ready to Install:Click Next, and the installation process starts.
j. Installing: This shows the installation progress. You can still cancel the installation if you

need to.
k. Completing the PostgreSQL Setup Wizard: Deselect the option to launch Stack Builder,

then click Finish.
Stack Builder lets you install additional tools and drivers. Youwon’t need any of these for
Universal Type Server.

6. On macOS, “eject” the PostgreSQL installer virtual disk.

You can delete the installer DMG or EXE file when you are finished.

PostgreSQL Download: https://www.enterprisedb.com/downloads/postgresql/

https://www.enterprisedb.com/downloads/postgresql/
https://www.enterprisedb.com/downloads/postgresql/
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Create a database
You need to create a database using the PostgreSQL administration tool. Universal Type Server will use
this database.
1. Start the pgAdmin application. pgAdmin runs as an always-on background application, and

presents its user interface in a web browser window.
On macOS, it is installed in the PostgreSQL ## folder inside the Applications folder.
On Windows Server, you can launch it from the Startmenu.

2. pgAdmin will ask you to set a master password. Make a note of it.
3. Expand the Servers entry in the Browser sidebar and select your server installation (PostgreSQL

##).
4. When prompted, enter the password for the postgres superuser login.
5. Create a login to use with the Universal Type Server database.

a. Click Object > Create > Login/Group Role.
b. In theGeneral tab, enter the login Name.
c. In the Definition tab, enter a Password for the login. Be sure tomake a note of the login and

password.
You should leave the Account expires field empty (so the password never expires).
LeaveConnection limit set to -1, allowing unlimited connections.

d. Click Save.
6. Create the Universal Type Server database.

a. Click Object > Create > Database.
b. In theGeneral tab, enter a name in the Database field. Make a note of this.
c. Select the login that you just created from theOwnermenu.
d. Click Save.

To exit pgAdmin, close the web browser window. If you are prompted to stay or leave the page, click
Leave.

To stop the pgAdmin application on macOS, click the pgAdmin icon in the menu bar (an elephant
head ), then choose Shut Down Server.

To stop the pgAdmin application on Windows Server, right-click the pgAdmin icon in the notification
area (an elephant head ), then choose Shut down server.

Converting between database types
With Universal Type Server Enterprise and an appropriate SQL database server installed, converting
between two different database types is the relatively simple process of backing up and restoring.

Youmay need to convert between one database type and another if you need to:
n Upgrade from the embedded database to an external SQL database.
n Troubleshoot an issue and want tomaintain continuity of connection for your users.
n Perform necessary maintenance on the external SQL server.
n Port your database from one database server type to another.

In general, to convert from one database to another, backup the source database, change the
database type in Universal Type Server, then restore the backup.

Warn users
Before beginning the process, warn users that they will be logged out of Universal Type Server
automatically during the backup process.

To ensure that all current data is captured and not modified between the backup and restore processes,
users should not log back in until after the upgrade process is complete.
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Backup the current database
Before you begin the conversion process, it is essential that you create a backup file of your current
installation. This backup file will be used to transfer your data between the source and target database
servers.

To backup your current Universal Type Server to your current backup location:
1. Under Datastore on the left, click Backups.
2. Note your current backup location, and click Backup now.

Switch to the new database server
The process to switch from one database server to another varies depending upon the new database
server you are choosing, as well as the source database type.

If you are moving from the native, embedded Universal Type Server database to a new external SQL
database server, or are moving from one type of external database to another:
1. Follow the instructions to install an external database (see Installing an external database on

page 35).
This includes creating a new account, creating a new database, and connecting Universal Type
Server to the new database.

2. Proceed to the next step to restore your backup file.

If you are moving an external database server to an embedded Universal Type Server database:
1. Open your web browser and start the Server Administration application.
2. Under Datastore on the left, click Database.
3. Choose Database Type > Internal UTS.
4. Click New Datastore.
5. Proceed to the next step to restore your backup file.

Restore the backup
Restoring a previous backup automatically populates your new database, and performs any necessary
upgrades to the data so that it is compatible with the current version of Universal Type Server.

Follow the instructions for restoring a backup (see Restoring a backup on page 30). This populates your
new database with your previous data.

Your database is now converted to the new database type and ready to be used.

Verify database creation and connection
After you’re done restoring the backup, check the status page of the Universal Type Server, Server
Administration application to confirm that the server has stopped and restarted. This is your indication
that the datastore has been created and the server is running. See the list of External database error
messages on the next page for solutions to common issues.
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External database error messages
If you are having problems connecting to an external SQL database, Universal Type Server logs pertinent
information that can help diagnose potential problems. This information is displayed in the Status page
of the Server Administration application, and is also included in the extensis.admin.log file.

To view server status:
1. Open your web browser and start the Server Administration application.
2. Click Status in the menu on the left to display the server status page. The status window displays

the extensis.admin.log file indicating the most recent server activity.
3. Check for any error messages.

Some of the possible errors are listed in the following chart.

If you are having trouble addressing a connection issue, use this Support Form to submit your issue to
Extensis. Be sure to note any specific error messages.

ERROR MESSAGE POTENTIAL ISSUE

Error creating new datastore: Unable to connect
to database server: Network error IOException:
Connection refused: connect

Unable to connect to the specified SQL Server

Error creating new datastore: Unable to connect
to database server: Login failed for user
‘username’

SQL database login authentication failure. This
may happen in the case of wrong password,
incorrect username, nonexistent username, or
improper user permissions.

Error creating new datastore: Unable to connect
to database server: Cannot open database
“databasename” requested by the login. The
login failed.

The SQL database does not exist, or was not
properly created.

Configuring automatic failover services
Enterprise users can configure a system tomaximize server uptime. By setting up a simple failover
system, you gain:

n Maximum server uptime
n Data consistency
n Seamless client switching when needed
n A failover license is included with the Enterprise installation

If the primary Type Server fails, client requests are automatically and seamlessly routed to the
secondary Type Server. End users will not be aware of any change in the system.

Support Form: https://help.extensis.com/hc/en-us/requests/new/

https://help.extensis.com/hc/en-us/requests/new/
https://help.extensis.com/hc/en-us/requests/new/
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Recommended configuration
A proxy failover configuration that is simple to set up and maintain includes the following systems:

n A primary Universal Type Server
n A secondary (or backup) Universal Type Server
n A proxy server
n A database server
n A file server for housing the Universal Type Server font vault

Note that each of these servers should have its own backup mechanism.

The first diagram shows the components and the relationship between them.

A: Client system B: Proxy serverC: Primary Type Server
D: Secondary Type Server E: Database server F: Type Server font vault

The second diagram shows how the backup Type Server takes over if the primary Type Server fails.

A: Client system B: Proxy serverC: Primary Type Server
D: Secondary Type Server E: Database server F: Type Server font vault
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Setup
NOTE: All servers in this configuration need to be on the same subnet.

In the following instructions, when we refer to the applications folder, it is the folder named
“applications” located inside the Universal Type Server folder. By default, this folder would be:

Windows: C:\Program Files\Extensis\Universal Type Server\applications\
Macintosh: /Applications/Extensis/Universal Type Server/applications/

The instructions for configuring your servers are different depending on whether you are setting up your
system for the first time, upgrading an existing system that uses a native database, or upgrading a
system that uses an external SQL database.

Downloads
Youwill need to download these files to configure your servers.
Windows

n Apache Tomcat™ version 6.0.35 (do not download a newer version)
for 64-bit Windows: https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x64.zip
for 32-bit Windows: https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x86.zip

n Java JDK
https://www.oracle.com/technetwork/java/javase/downloads/index.html
a. Scroll down the page to the section labeled Java SE 8u###, with a button labeled JDK

Download (not Oracle JDK Download).
b. Click JDK Download.
c. Scroll down the page to the section labeled Java SE Development Kit 8u###.
d. Click Accept License Agreement.
e. Click the download link forWindows x64 (for 64-bit Windows) orWindows x86 (for 32-bit

Windows).
n Notepad++ (recommended but not required; this is a free text editor with syntax highlighting)

https://notepad-plus-plus.org/

Apache Tomcat for 64-bit Windows: https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x64.zip

Apache Tomcat for 32-bit Windows: https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x86.zip

Java JDK: https://www.oracle.com/technetwork/java/javase/downloads/index.html
Notepad++: https://notepad-plus-plus.org/

https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://notepad-plus-plus.org/
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://notepad-plus-plus.org/
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Macintosh
n Apache Tomcat version 6.0.35 (do not download a newer version)

https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
n Java JDK

https://www.oracle.com/technetwork/java/javase/downloads/index.html
a. Scroll down the page to the section labeled Java SE 8u###, with a button labeled JDK

Download (not Oracle JDK Download).
b. Click JDK Download.
c. Scroll down the page to the section labeled Java SE Development Kit 8u###.
d. Click Accept License Agreement.
e. Click the download link forMac OS X x64.

n BBEdit (highly recommended; this is a high-powered text editor with syntax highlighting and
command-line integration that includes a very capable “free” mode)
https://www.barebones.com/products/bbedit/
Install BBEdit, launch it, and choose Install command line tools from the BBEditmenu.
The instructions that follow assume youwill be using BBEdit; adjust them accordingly if you are
using a different editor (such as vi).

Other important tidbits
Other information youwill need to know for configuring your servers:

n Youwill need the IP address for both the Primary Type Server and the Secondary Type Server.
n If you are configuring your system for single-sign on using Kerberos, the Primary and Secondary

Type Servers need to be configured with their own service accounts on the domain server, their
own Service Principal Names (SPNs), and their own keytabs.

Apache Tomcat for macOS: https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-
6.0.35.zip

Java JDK: https://www.oracle.com/technetwork/java/javase/downloads/index.html
BBEdit: https://www.barebones.com/products/bbedit/

https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://www.barebones.com/products/bbedit/
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
https://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://www.barebones.com/products/bbedit/
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Setting up for the first time
Primary Type Server

IMPORTANT: If you use Universal Type Server’s built-in backup scheduler to back up your datastore,
you only need to schedule backups on the Primary Type Server.

The Type Server will be in Standby mode while the scheduled backup is running, and will return to
normal access when the backup completes.

1. Install the Primary Universal Type Server. See Installation overview on page 9.
2. Set up the Primary Type Server with the external database and external font vault. See External

SQL database on page 34 andMoving the vault on page 27.
3. Stop the Primary Type Server. See Stopping, starting, and restarting the server on page 23.
4. Run the failover setup script on the Primary Type Server.

Windows:
a. Open a command prompt window.

Windows Server 2012: PressWIN+X and chooseCommand Prompt.
Windows Server 2008: Click Start, choose Run, type cmd and press ENTER).

b. Change to the applications directory inside the Universal Type Server directory.
Type cd "C:\Program Files\Extensis\Universal Type Server\applications" and press
ENTER.

c. To run the script, type win-failover-setup primary and press ENTER.
Macintosh:
a. Open the Terminal application (inside the Utilities folder in the Applications folder on your

server’s hard disk).
b. Change to the applications directory inside the Universal Type Server directory.

Type cd "/Applications/Extensis/Universal Type Server/applications" and press
RETURN.

c. To run the script, type sudo ./mac-failover-setup.sh primary and press RETURN, then
type your administrator password.

5. Start the Primary Type Server.

Configuring the Proxy Server
The following installations and other procedures are performed on the system that will become the Proxy
Server.
1. Install the Java JDK.

To confirm that the installation is functioning, open Command Prompt (Windows) or Terminal
(macOS) and type java -version. This should display the version number of the JDK that you just
installed.
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2. Create a system variable named JAVA_HOME set to the installation path of the Java JDK, then add
this variable to the system PATH variable.
Windows:
a. Open the Control Panel, click System, then click Advanced System Settings on the left.
b. In the System Properties window, click Environment Variables.
c. Create a new System Variable and give it the name JAVA_HOME, set its value to the path to

the JDK installation folder (for example, C:\Program Files\Java\jdk1.7.0_80\), then click
OK.
Make sure to enter the path to the JDK files, not the JRE. Alsomake sure to add the trailing
backslash (\) character.

d. Edit the System Variable PATH, and add the following to the end of the existing value:
;%JAVA_HOME%bin;
IMPORTANT: Be sure to add to the end of the variable value; do not replace it!

e. Click OK in the Environment Variables window, click OK in System Properties, then close the
Control Panel.

f. Confirm that the environment is set correctly. Open a command prompt window, type path,
and press ENTER. The last element of the PATH variable should be the full path to the JDK bin
folder (for example, C:\Program Files\Java\jdk1.7.0_80\bin).

Macintosh:
These instructions assume you are using BBEdit’s command-line tools for editing. Adjust them
accordingly if you are using a different editor.
a. Open Terminal.
b. Type bbedit .profile and press RETURN.

The .profile file in your user directory is a shell script that is run when you log in to your
Mac; we will use this to set environment variables.

c. Scroll to the end of the .profile file. (This file may very well be empty.)
d. Type export JAVA_HOME=/Library/Java/JavaVirtualMachines/jdk1.7.0_80.jdk and

press RETURN.
Be sure to use the correct path for your version of the Java JDK.

e. Type export PATH=$JAVA_HOME/bin:${PATH} and press RETURN.
Remember that variable and path names are case sensitive!

f. Save the file and exit BBEdit.
g. Confirm that the environment variables are set correctly. Log out from your Mac, then log

back in. Open Terminal and type env.
You should see that the PATH variable now starts with the full path to the JDK bin folder, and
the JAVA_HOME variable is set as expected.

3. Install Apache Tomcat.
Make a note of where you install Tomcat; you’ll need to know its location in later steps.

4. Copy the file esp-proxy.war, located in the applications folder, into the Tomcat webapps folder.
5. In the Tomcat webapps folder, rename the ROOT folder to ROOT_original, then rename the file

esp-proxy.war to ROOT.war.
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6. Start the Proxy.
Windows:
a. Open a command prompt window.
b. Change to the bin directory of your Tomcat installation. Type (for example) cd "C:\Program

Files\apache-tomcat-6.0.35\bin" and press ENTER.
c. Type startup and press ENTER.
Macintosh:
a. Open Terminal.
b. Change to the bin directory in your Tomcat installation. Type (for example) cd

"/Applications/apache-tomcat-6.0.35/bin" and press RETURN.
c. Type sudo ./startup and press RETURN, then type your administrator password.

7. Edit data.xml to include the IP addresses of your Primary and Secondary Type Servers.
From the Tomcat installation directory, data.xml is in /webapps/ROOT/WEB-INF/config/.
a. Open data.xml in a text editor.
b. Find the lines that start with <server domainName=. Substitute the IP address for your

Primary Type Server for the text UTSserver1, and the IP address for your Secondary Type
Server for the text UTSserver2. The lines should look something like this:
<server domainName="192.168.0.101:8080" />
<server domainName="192.168.0.102:8080" />
If you have changed the port used for the HTTP/Web Service from the default value of 8080,
then use that value in the lines above.

c. Find the line that starts with <esp-proxy. If you have changed the port used for the
HTTP/Web Service from the default value of 8080, then enter that value for the servicePort
parameter. If you have changed the port used for the HTTPS/Web Service from the default
value of 8443, then enter that value for the securePort parameter.

d. Save your changes and close data.xml.
8. Youwill need tomanually replace the server start/stop script included with the Tomcat

distribution.
Windows:
a. Make a backup copy of the file catalina.bat, located in Tomcat’s bin directory.
b. Locate the file catalina.bat at /webapps/ROOT/WEB-INF/config/ in the Tomcat installation

directory.
c. Copy this file to Tomcat’s bin directory, replacing the existing file.
Macintosh:
a. Make a backup copy of the file catalina.sh, located in Tomcat’s bin directory.
b. Locate the file catalina.sh at /webapps/ROOT/WEB-INF/config/ in the Tomcat installation

directory.
c. Copy this file to Tomcat’s bin directory, replacing the existing file.
d. Make the catalina.sh script executable. In a Terminal window, enter chmod 755 followed by

the path to the file. Example:
chmod 755 /Applications/apache-tomcat-6.0.35/bin/catalina.sh
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9. Because the default Tomcat installation does not include an open port for secure traffic, youwill
need to replace the existing server.xml file with one included with Universal Type Server.
a. Make a backup copy of the Tomcat default server.xml file located in Tomcat’s conf

directory.
b. Locate the server.xml file at /webapps/ROOT/WEB-INF/config/ in the Tomcat installation

directory.
c. Copy this file to Tomcat’s conf directory, replacing the existing file.
d. If you have changed the HTTP/Web Service port from the default value of 8080, then youwill

need to edit the server.xml file and change all occurrences of the text port="8080" to
include the updated port value.
If you have changed the HTTPS/Web Service port from the default value of 8443, then you
will need to change all occurrences of the text port="8443" and redirectPort="8443" to use
the updated port value.

10. Shut down the Proxy.
Windows:Open a command prompt, switch to Tomcat’s bin directory, type shutdown, and press
ENTER.
Macintosh:Open Terminal, switch to Tomcat’s bin directory, type sudo ./shutdown and press
RETURN, then type your administrator password.

11. Start the Proxy again.
Configuring Tomcat as a Windows service
If your Proxy is running on a Windows server, you can configure Tomcat as a service so that it starts
automatically.
1. Open a command prompt with Administrator privileges.
2. Change to Tomcat’s bin directory.

Example: cd "C:\Program Files\apache-tomcat-6.0.35\bin".
3. Type setup.bat install and press ENTER.

This installs Tomcat as a service; youwill need to configure the service to start when youwant it to. Run
services.msc, right-click on the Tomcat service, select Properties, set the Startup Type, click OK, then
close the Services window. Youmay also need to restart your server.
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Secondary Type Server
1. Install the Secondary Type Server.
2. Stop the Secondary Type Server.
3. Run the failover setup script on the Secondary Type Server. Follow the instructions above, but

change the script parameter primary to backup in the final step (type sudo ./mac-failover-
setup.sh backup or win-failover-setup backup).

NOTE: If you have multiple Universal Type Servers that you are configuring with failover service,
youwill need to specify a unique multicast address for each pair of Primary and Backup Type
Servers. For further instructions, run the failover setup scripts with no parameters (i.e., sudo
./mac-failover-setup.sh or win-failover-setup.

4. Activate your Type Server license on the Secondary Type Server.
a. Open the Management application and log in.
b. Click the Administration tab, then click Licenses.
c. Click Remove, then click OK.
d. Click Activate Universal Type Server.
e. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.
Be sure to activate the same Enterprise license used for the Primary Type Server.

5. Start the Server Admin application on the Secondary Type Server.
6. Connect to the existing external database.

The button should be labeled Join Datastore instead of New Datastore.
7. Start the Secondary Type Server.
8. Connect to the existing external vault.

Confirm configuration
NOTE: This step helps you confirm that your servers are running correctly and is completely optional.

View the most recent log file to confirm that both Primary and Secondary Type Servers are running.

Log files are in the logs folder inside the Tomcat installation directory. The most recent Tomcat log file is
named catalina.out.

Look near the end of the file for entries that resemble the following:
INFO: PRIMARY Universal Type Server : 192.168.0.101:8080 is up.
. . .
INFO: BACKUP Universal Type Server : 192.168.0.102:8080 is up.

Upgrading an existing native database
Your existing Universal Type Server will become your Primary Type Server.
1. Move your vault to an external location where it can be shared by your Primary and Secondary

Type Servers. SeeMoving the vault on page 27 for instructions.
2. Back up your existing datastore. See Backing up the datastore on page 29.
3. Configure your external database. See External SQL database on page 34.
4. Restore your datastore backup. See Restoring a backup on page 30.

This copies your previous native database to the new SQL database.
5. Continue from step 3 under Setting up for the first time on page 45.
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Upgrading an existing SQL database
Your existing Universal Type Server will become your Primary Type Server. These instructions assume your
SQL database resides on a separate server from your Universal Type Server.
1. Move your vault to an external location where it can be shared by your Primary and Secondary

Type Servers. SeeMoving the vault on page 27 for instructions.
2. Back up your existing datastore. See Backing up the datastore on page 29.

This is a precautionary measure.
3. Continue from step 3 under Setting up for the first time on page 45.
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Modules
Universal Type Server now supports add-in modules that provide functionality for specific tasks, such as
providing fonts in an automated workflow using Adobe® InDesign® Server.

To add a module’s functionality, you need to install the module on the same system with your Universal
Type Server, then enter a license for the module in the Server Admin application.

Specific modules may have other requirements; see the individual topics for each module.

To purchase a module, contact your Extensis sales representative.

FontLink

A: Adobe InDesign documents B: FontLink C: InDesign Server D: Font files
E: Universal Type Server F: PDF outputG: EPUB output H: Other kinds of output

Automates font preflighting
FontLink is a module for Universal Type Server that dynamically delivers fonts for documents in
automated publishing workflows using Adobe® InDesign Server®.

Having the correct fonts during the production process is critical for any InDesign Server workflow.
Missing or incorrect fonts can quickly derail any automated processes and pull people away from other
critical tasks.

FontLink solves the font management problem by easily plugging-in to any automated, multi-channel
publishing workflow, nomatter how complex.

Speeds up document processing
FontLink examines and gathers fonts for InDesign documents at any point before they are handed off to
InDesign Server, removing manual document processing tasks for output.
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Ensures the correct fonts with Font Sense
FontLink leverages the same powerful Font Sense technology as Universal Type Server.

During the creative process, Universal Type Server’s font auto-activation plug-ins automatically embed
Font Sense metadata to identify and record all of fonts in use in InDesign documents.

FontLink reads Font Sense metadata from the InDesign document and collects the required fonts from
Universal Type Server for output.

Easy Content Management System integration
FontLink is easily integrated with most popular professional content management software solutions
and fits any point prior to InDesign Server processing.

Jobs are processed using straightforward input, output and error folders, ensuring the most
straightforward integration.

Delivers real-time alerts
Publishing administrators stay informed with instantaneous email alerts of font-related errors. Daily
reports of completed and failed jobs ensure efficient server monitoring and record keeping.

Contact us for pricing details and to discuss your automated publishing workflow.

FontLink and font compliance
FontLink provides copies of your document fonts to InDesign Server on demand for processing. To remain
compliant, it is important that you license your fonts for server or production use as required by their
foundries. Most Foundries offer different licensing options for the various output options (i.e. PDF output,
ePub, etc.). Please consult foundry (EULA) End User License Agreements for more information about
storing your fonts on a Server and other required licensing details.

FontLink system requirements
FontLink Module
FontLink Module is installed on the system running Universal Type Server.

n Universal Type Server Enterprise Edition version 6.1.7 or later
n macOS 10.10 through 10.14

— OR —
Windows® Server 2012 R2 or Windows Server 2016

n 1.3 GB hard drive space

FontLink Connector
FontLink Connector is installed on the system running InDesign Server.

n Adobe InDesign Server CC 2017–CC 2019
n macOS 10.10 through 10.14

— OR —
Windows® Server 2012 R2 or Windows Server 2016

n FontLink Connector requires 1.3 GB hard drive space per instance of Adobe InDesign Server
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Supported documents
FontLink processes InDesign documents (INDD) and templates (INDT) from InDesign CS6 and later. In
order to work with FontLink, documents must be saved using the Extensis auto-activation plugin from
Universal Type Client version 4.0.2 or later (or Suitcase Fusion 6 v17.0.0 or later). Ensure that the Enable
Font Sense Support option is turned on for each user in the InDesign auto-activation preferences.

You can easily upgrade documents that don’t meet these requirements by opening them in a supported
version of InDesign with the auto-activation plug-in, then re-saving them.

For font compliance purposes, InDesign files processed by FontLink must include fonts hosted on your
Universal Type Server. Files containing fonts not recognized by Universal Type Server will raise an error
during processing.

Setting up FontLink
A FontLink installation consists of several components:

n Universal Type Server
n FontLink Module
n Adobe InDesign Server
n FontLink Connector

If your organization has an email server, FontLink can send a daily digest of completed jobs, or alert
administrators to files that can’t be processed.
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Order of installation
Before you can install and configure the FontLink-specific components of Universal Type Server, you
need to have a working installation of Adobe InDesign Server CS6 or later, and a working installation of
Universal Type Server Enterprise Edition version 5.1 or later.

Once you have your servers running, do the following:
1. Install FontLink Connector on your InDesign Server system.
2. Create the following folders on your InDesign Server system: a folder for jobs to be processed by

FontLink (called the Input folder), a folder for jobs that have been processed successfully (called
theOutput folder), and a folder where jobs that can’t be processed are sent (called the Errors
folder).
NOTE: These folders can be created on network volumes. Due to platform-specific differences
results may vary between operating systems.

3. By default, InDesign Server uses port 12345 to identify its first running instance. You can change
this if necessary. If you are running multiple instances of InDesign Server, youmust configure
each with its own unique port number. See the InDesign Server documentation for port-specific
setup instructions.

4. Install the FontLink Module on the Universal Type Server system.
5. Reactivate your Universal Type Server license.

a. Open the Management application and log in.
b. Click the Administration tab, then click Licenses.
c. Click Remove, then click OK.
d. Click Activate Universal Type Server.
e. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.

For more information, see the documentation for Universal Type Server Management.
6. Enter the details for your email server in the Server Admin application. SeeConfiguring FontLink

notifications on page 56.
7. Connect each instance of InDesign Server in the Server Admin application. SeeConnecting to

InDesign Server on the next page.
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Connecting to InDesign Server
In order for the FontLink Module of Universal Type Server to communicate with a running copy of
InDesign Server and its corresponding FontLink Connector, you need to provide information to Universal
Type Server.

To identify your InDesign Server to FontLink, clickModules in the menu on the left, then click
Add a Server Instance.

n Instance Name: This identifies a specific running instance of InDesign Server in logs, email
digests, and error emails. Use a friendly and descriptive name, such as 3rd floor Production.

n IP Address (with port): This is the IP address of the system that hosts the InDesign Server and
FontLink Connector. Include the specific port for the instance of InDesign Server. By default,
InDesign Server runs on port 12345; see your InDesign Server documentation to change this.
Example:123.45.67.89:12345

n Input Folder: Enter the full path to the folder on the InDesign Server system where FontLink will
watch for jobs to process. This folder can be local on the InDesign Server or on a network volume
accessible to the InDesign Server.
Examples:
l D:\data\fontlink-input\ (Windows local folder)
l Z:\production\fontlink-in\ (Windows remote folder; drive Z: is mapped to a network share

or folder)
l /Users/Shared/FontLink input/ (Macintosh local folder)
l /Volumes/Production/FontLink in/ (Macintosh remote folder; the volume Production must

be mounted on the InDesign server system)
n Output Folder: Enter the full path to the folder where FontLink will place processed files.
n Error Folder: Enter the full path to the folder where FontLink will move jobs that can’t be

processed.
n Daily Digest Notifications: Enter a comma-separated list of email addresses where youwould

like to send a daily digest listing jobs successfully processed by this InDesign Server instance. The
daily digest is sent once a day for jobs processed during the previous 24 hours.This feature
requires that you enter your network’s email server details in the FontLink Module panel.

n Error Notifications: Enter a comma-separated list of email addresses where youwould like to
send messages about jobs that could not be processed. These messages are sent immediately.

Enter the above information and click Save.

Adding more connections
You can connect FontLink Module tomore than one instance of InDesign Server. In this way, you can
leverage the additional processing power of your InDesign Server system.

To add another connection, follow the steps above. Be sure to enter a unique Instance Name and port
value for each instance of InDesign Server.

Your initial license for FontLink allows up to three connections to InDesign Server. Contact your Extensis
Sales representative for information about additional connections.
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Removing a connection
If you need tomake a change to one of your InDesign Server connections, you need to remove the
connection and then re-create it. Before you do so, make sure you have copied down any required
information.

To remove a connection:
1. ClickModules in the list on the left.
2. Select the InDesign Server instance connection that youwant to remove.
3. Click Details and copy down any information that youwill need to re-create the instance, then

click Back.
4. Select the Server Instance and click Delete. In the confirmation dialog, click OK.

Follow the steps above to re-create the Server Instance.

Configuring FontLink notifications
FontLink can send email notification when a job cannot be processed, and can also send a daily digest
listing successfully completed jobs. In order to have FontLink send notifications, you need to enter
information about your organization’s email server.

Supported email servers
Any SMTP email server can be used to send FontLink notifications. The email server needs to be on the
same network as the FontLink module, and needs to support incoming messages without authentication.

Adding your email server
To add your email server’s details so that FontLink can send job notifications:
1. ClickModules in the menu on the left.
2. Under Email Services Setup, click Setup.
3. Enter the domain-specific name of your email server (such as smtp.example.com).
4. Enter the port used to accept incoming email message requests.
5. Click Save.

Removing your email server
To remove your email server, clickModules, then click Remove under Email Service.

Restarting FontLink services
NOTE: Universal Type Server must be running before you can restart the FontLink Module service.

Windows
To restart the FontLink Module service on a Windows server running Universal Type Server
1. Open the Services browser (Control Panel > Administrative Tools > Services, or type

servces.msc in the Run dialog).
2. Select FontLink Module Service for IDS in the list of services and click Restart Service on the

toolbar.

To restart the FontLink Connector service on a Windows server running InDesign Server
1. Open the Services browser.
2. Select FontLink Connector Service for IDS in the list of services and click Restart Service on

the toolbar.
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Macintosh
To restart the FontLink Module service on a Macintosh server running Universal Type Server:
1. Open a Terminal window.
2. Type sudo launchctl unload

/Library/LaunchDaemons/com.extensis.ids.fontlink.module.jboss.plist and press
RETURN. Enter your computer’s administrator password when prompted.
This stops the FontLink Module service.

3. Type sudo launchctl load
/Library/LaunchDaemons/com.extensis.ids.fontlink.module.jboss.plist and press
RETURN.
This starts the FontLink Module service again.

To restart the FontLink Connector service on a Macintosh running InDesign Server:
1. Open a Terminal window.
2. Type sudo launchctl unload

/Library/LaunchDaemons/com.extensis.ids.fontlink.connector.jboss.plist and press
RETURN.
This stops the FontLink Connector service.

3. Type sudo launchctl load
/Library/LaunchDaemons/com.extensis.ids.fontlink.connector.jboss.plist and press
RETURN.
This starts the FontLink Connector service again.

FontLink technical details
Ports
FontLink Module requires port 8485 and FontLink Connector requires port 8486 to be open so the two
servers can communicate with each other. When Module and Connector are installed on the same server
both ports must be open.

These port numbers cannot be changed, so if you have other software using either of these ports you
should change the ports used by the conflicting software.

Log files
Each FontLink component records information about its startup condition and all transactions in log
files.
FontLink Module log files
FontLink Module maintains two log files:

boot.log: records environment information and status when the FontLink Module starts up
Server.log: identifies JBoss and MySQL system errors and lists all jobs processed

FontLink Module log files are located on the Universal Type Server system:
Windows: C:\Program Files\Extensis\FontLinkModule\jboss\standalone\log\
Macintosh: /Applications/Extensis/FontLinkModule/jboss/standalone/log/
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FontLink Connector log files
FontLink Connector maintains four log files:

boot.log: records environment information and status when the FontLink Connector starts up
Server.log: identifies FontLink Connector system errors related to JBoss or MySQL
fontActivationFailure.log: lists jobs that FontLink could not process
fontActivationSuccess.log: lists jobs that FontLink processed successfully

FontLink Connector log files are located on the InDesign Server system:
Windows: C:\Program Files\Extensis\FontLinkConnector\jboss\standalone\log\
Macintosh: /Applications/Extensis/FontLinkConnector/jboss/standalone/log/

Uninstalling FontLink Connector
Note: If you uninstall FontLink Connector, any workflows that rely on its Input Folder location may need
to be modified.

To uninstall FontLink Connector on Windows:
1. Choose Start > Control Panel.
2. Click Programs and Features.
3. Select Extensis FontLink Connector.
4. Click Uninstall.

To uninstall FontLink Connector on macOS:
1. Open the folder Applications > Extensis > FontLinkConnector.
2. Double-click the FontLink Connector Uninstaller.
3. Follow the instructions on screen to uninstall the FontLink Connector.

Uninstalling FontLink Module
To uninstall FontLink Module on Windows:
1. Choose Start > Control Panel.
2. Click Programs and Features.
3. Select Extensis FontLink Module.
4. Click Uninstall.

To uninstall FontLink Module on macOS:
1. Open the folder Applications > Extensis > FontLinkModule.
2. Double-click the FontLink Connector Uninstaller.
3. Follow the instructions on screen to uninstall the FontLink Module.

Font Connector for Esko ArtPro+
Fonts play an integral role in print and packaging design. Ensuring accuracy and consistency is critical
for producing a high-quality product.

Font Connector for Esko ArtPro+ allows your users to:
n Immediately access the fonts they need
n Make on-the-fly, live text edits in PDFs
n Fix critical, last-minute text changes during the prepress stage
n Increase workflow efficiency
n Save time and money by reducing font inconsistencies and errors

Font Connector for Esko ArtPro+ is an add-on module for Universal Type Server.

Contact Extensis sales to purchase a license.

Contact Sales: https://www.extensis.com/contact-us-form/

https://www.extensis.com/contact-us-form/
https://www.extensis.com/contact-us-form/
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ArtPro+ and PDFs
ArtPro+ allows you to edit normalized PDFs with embedded fonts.

Typically a PDF will only contain a subset of the font in use, so attempting to edit text with an embedded
font results in the font being replaced by a system font.

With FontConnector for ArtPro+ and Universal Type Client, you can edit the PDF and ensure that the
original font is retained, with all the appropriate characters embedded. NOTE: The original font must be
installed on your Universal Type Server.

System requirements
n Esko ArtPro+ version 18.0 or later (see

https://wiki.esko.com/pages/viewpage.action?pageId=211029673)
n Universal Type Server version 6.1.7 or later (Professional or Enterprise)
n Universal Type Client version 6.1.7 or later (installed on the same system with ArtPro+)

Configuring Font Connector for ArtPro+
n Font Connector for ArtPro+ allows Universal Type Client to automatically activate fonts used in

ArtPro+ documents.
n Reactivate your Universal Type Server license.

a. Open the Management application and log in.
b. Click the Administration tab, then click Licenses.
c. Click Remove, then click OK.
d. Click Activate Universal Type Server.
e. Enter the credentials for your License Administrator account, then click Submit.

If you have multiple Type Server licenses with the same License Administrator, choose the
appropriate license and click Select.

For more information, see the documentation for Universal Type Server Management.
n Install Universal Type Client on the same system with ArtPro+, and connect to your Universal Type

Server.
n In ArtPro+, open Preferences and click Extensis.

l Choose Enable Font Connector to allow ArtPro+ to communicate with Universal Type Client.
l Choose Activate entire font family to have Universal Type Client activate all members of the

font family (i.e. Regular, Bold, Italic, and Bold Italic). With this option off, Type Client will only
activate the precise face used in your document (for example, Helvetica Bold).

l Choose Deactivate fonts on application close to have Universal Type Client deactivate any
fonts activated by ArtPro+ for your document when you quit ArtPro+.

ArtPro+ System Requirements: https://wiki.esko.com/pages/viewpage.action?pageId=211029673

https://wiki.esko.com/pages/viewpage.action?pageId=211029673
https://wiki.esko.com/pages/viewpage.action?pageId=211029673
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Command line administration
tool
Universal Type Server contains a command line tool that exposes a number of the functions of the Server
Administration application in command line format.

In some cases, this tool allows for more granular control of certain operations and allows these
operations to be scripted.

The tool script name is esp-admin and is available in both batch (.bat) and shell script (.sh) formats for
use on Windows and Macintosh operating systems, respectively.

The tool resides inside of the Universal Type Server’s applications subfolder. For example:
Windows: C:\Program Files\Extensis\Universal Type Server\applications\
macOS: Applications/Extensis/Universal Type Server/applications/

NOTE: When running the esp-admin.bat using the Windows command prompt, any non-ASCII
characters are displayed as question marks. This can cause issues when displaying items that allow
Unicode characters, such as the Bonjour server name.

Viewing server settings with the command
line tool
If you are unable to use the web application to initially open the Server Administration application, you
can use the command line tool to view pertinent server settings. This can happen if you are installing
onto a headless server, and there is a port conflict with the default Server Administration port.

To view server settings with the command line tool on Windows:
1. Open a Command Prompt window.

Click Start > Run, type cmd, and press ENTER.
2. At the command prompt enter:

cd C:\Program Files\Extensis\Universal Type Server\applications\
3. Enter the following command to list server settings:

esp-admin -username administrator -password password -getserversettings

NOTE: If you have changed the default administrator password, enter it after -password in the
command.

To view the server settings with the command line tool on macOS:
1. Start the Terminal application located in the Utilities folder inside the Applications folder.
2. At the prompt, enter:

cd "/Applications/Extensis/Universal Type Server/applications/"
3. Enter the following command to list server settings:

sudo ./esp-admin.sh -username administrator -password password -getserversettings

The server lists a number of important server settings, including repository location, backup location,
and the ports currently in use. The port listed after esp.port.admin-web-app= is the port currently in use
for the Server Administration application.
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Properties files
Many commands require the inclusion of data in a “properties” file to function properly. These files are
basically lists of options and the selected values for those options.

Properties files must be saved as standard ASCII text files, and cannot include any high
ASCII characters.

The following is an example of the contents of a properties file.
esp.backup.location=C://backups/
esp.backup.filename=mybackup.tar
esp.option.backup.stayinquiescentmode=false

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or C://Program
Files/Extensis/Universal Type Server/data/vault.

Properties files are used with the following commands:
backupdatastore (see backupdatastore on the next page.)
createdatastore (see createdatastore on page 63.)
moverepository (seemoverepository on page 66.)
restoredatastore (see restoredatastore on page 67.)

Specifying a username and password
Almost every command line operation requires the addition of a username and password that has
administrative privileges.

The username and password can be specified in the command line each time a command is executed, or
it can be specified as an environment variable.

The two environment variables that can be set are:
n ESP_ADMIN_USER, which by default is set to the value administrator, the Server Administrator

username; and
n ESP_ADMIN_PW, which by default is set to the value password, the default Server Administrator

password.

The following is an example of specifying the username and password in the Windows command line
when adding a serial number:

esp-admin ESP_ADMIN_USER ESP_ADMIN_PW -addserialnumber XXXX-1234-ABCD-EFGH-IJKL-MNOP

For assistance setting environment variables, see the documentation for your operating system.



- 62 -

Commands
backupdatastore
Use this command to backup the datastore. This command can be used alone, or with a properties file
that contains multiple parameters (see Properties files on the previous page). In addition, the option to
dismiss all interactive confirmation prompts is controlled with the -force option.

-backupdatastore [-properties properties.txt] [-force]
-properties: use properties specified in the file properties.txt.
-force: automatically accept all interactive confirmation prompts.

The properties file is a plain text file that can contain any or all of the following optional settings:

PROPERTY DESCRIPTION REQUIRED

esp.backup.location The complete path to the backup directory. If
not specified, the default backup directory is
used.

No

esp.backup.filename Name of the backup file. The backup is stored
as a .ZIP compressed archive; youmust include
the .ZIP extension in the filename. If you don’t
specify a filename, the backup will be named
using the pattern year_mo_dy_hr_mn.zip.

No

esp.option.backup.
stayinquiescentmode

Specifies whether the server will be left in
“quiescent” or standby mode after the backup
is complete. Valid values are true or false; the
default is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or C://Program
Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username xxx -password xxx -backupdatastore -properties properties.txt -

force

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -backupdatastore -properties

properties.txt -force

canceldatastoreoperation
This command cancels any current datastore operation, and does not have any parameters.

-canceldatastoreoperation

Windows usage example:
esp-admin -username xxx -password xxx -canceldatastoreoperation

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -canceldatastoreoperation
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checkdatastoreoperationstatus
This command checks the status of any current datastore operations, and does not have any
parameters.

-checkdatastoreoperationstatus

Windows usage example:
esp-admin -username xxx -password xxx -checkdatastoreoperationstatus

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -checkdatastoreoperationstatus

createdatastore
This command creates a new datastore using a properties file. Before using this command, be sure to
have a backup of your current datastore.

This command relies upon the creation of a properties file (see Properties files on page 61). In addition,
the option to dismiss all interactive confirmation prompts is controlled with the force option.

-createdatastore -properties properties.txt [-force]

The following properties can be specified in the properties file.

PROPERTY DESCRIPTION REQUIRED

esp.repository.directory This is the name of the folder that contains
the datastore.

Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.database.driver Logical name of database type to use.
Currently the only supported value is
esp.database.driver.PostgreSQL.

Yes

esp.database.username The database user name. No

esp.database.password The database password. No

esp.database.hostport Host and port used to connect to the
database. Formatted host:port, for
example: localhost:3487.

No

esp.database.datapath Path to the database. If not specified, the
default location is used.

No

esp.option.backup.
stayinquiescentmode

Specifies that the server be left in quiescent
(standby) mode after creating the
datastore. Valid values are true or false.
Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or C://Program
Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username xxx -password xxx -createdatastore -properties properties.txt -

force

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -createdatastore -properties

properties.txt -force
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directorysynchronize
With directory integration, Universal Type Server is bound to a Directory Service. This command
synchronizes Universal Type Server with the Directory Service.

-directorysynchronize

Windows usage example:
esp-admin -username xxx -password xxx -directorysynchronize

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -directorysynchronize

forcelogouts
This command forces the logout of a specific user as identified by session ID (or GUID).

To identify a user’s session ID, use the getlogins command (see getlogins below). This command returns
a list containing the username, long username, IP address of login client, the login time, as well as the
necessary session ID which is also known as the user GUID.

-forcelogouts sessionID
Windows usage example:

esp-admin -username xxx -password xxx -forcelogouts 11110000-ABCD-89AB-FF00-
12345678ABC

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -forcelogouts 1234ABCD-FF00-BA98-00DD-

ABCDEF01234

forcelogoutswithfile
This command forces the logout of a list of users contained within a userlogout text file. The text file must
contain one user session ID (or GUID) per line.

To identify a user’s session ID, use the getlogins command. This command returns a list containing the
username, long username, IP address of login client, the login time, as well as the necessary session ID
which is also known as the user GUID.

-forcelogoutswithfile -file userlogout.txt
Windows usage example:

esp-admin -username xxx -password xxx -forcelogoutswithfile -file userlogout.txt

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -forcelogoutswithfile -file

userlogout.txt

getlogins
This command lists all users currently logged in to the Type Server and does not have any parameters.

This command returns a list containing the username, long username, IP address of login client, the login
time, and the session ID which is also known as the user GUID. The user session ID can be used to force
the logout of specific users using the forecelogouts or forcelogoutswithfile commands (see
forcelogouts above and forcelogoutswithfile above).

-getlogins

Windows usage example:
esp-admin -username xxx -password xxx -getlogins

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -getlogins
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getserversettings
This command displays a list of the current server settings.

-getserversettings

The following is a list of server properties displayed by this command:

PROPERTY DESCRIPTION

esp.container.autostart This is the autostart setting of the server: enabled or
disabled.

esp.core.bonjour.name The current Bonjour name of the server.

esp.core.repository.
location

The location of the server vault.

esp.core.service.backup.
directory

Directory where backup files are to be written. This path
should allow changes.

esp.core.service.backup.
schedule

Backup schedule expression. Expression must adhere to the
formats supported by Quartz.

esp.core.service.logging.
level

The logging level of the server: error, warn, info, or debug.

esp.core.service.logging.
location

Directory where logs are to be written. This path should allow
changes.

esp.core.service.state The current state of the server: started, stopped, or
standby.

esp.port.admin-web-app The Server Administration port, also called the Jetty Web
App port.

esp.port.bootstrap-jnp The Bootstrap JNP Server Bind Address port.

esp.port.http The User Management port. This port is also used for client
connection and also called the JBoss HTTP / Web Service
port.

esp.port.jmx-pooled The JMX Pooled Port.

esp.port.jmx-rmi The JMX RMI Object Port.

esp.port.rmi-naming The RMI Naming Service port.

esp.port.webservice The JBoss Webservice port.

Windows usage example:
esp-admin -username xxx -password xxx -getserversettings

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -getserversettings



- 66 -

moverepository
This command moves the font vault (also called the repository) to a new location. This command relies
upon the creation of a properties.txt file (see Properties files on page 61).

-moverepository -properties properties.txt
The following properties can be specified in the properties file.

PROPERTY DESCRIPTION REQUIRED

esp.repository.directory The top level of the datastore. Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.option.backup.
stayinquiescentmode

Specifies that the server be left in
quiescent (standby) mode after moving the
datastore. Valid values are true or false.
Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or C://Program
Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username xxx -password xxx -moverepository -properties properties.txt

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -moverepository -properties

properties.txt

reapseats
This command synchronously removes any unused client seats that have not synchronized with the
server within 30 days.

-reapseats

Windows usage example:
esp-admin -username xxx -password xxx -reapseats

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -reapseats
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restoredatastore
IMPORTANT: restoredatastore is destructive; it will replace your current datastore with the
contents of the specified backup. Be sure this is what youwant to do before you execute
restoredatastore.

Use this command to restore a backup copy of the datastore. This command relies upon the creation of a
properties.txt file (see Properties files on page 61). In addition, the option to dismiss all interactive
confirmation prompts is controlled with the -force option.

-restoredatastore -properties properties.txt -force

The following properties can be specified in the properties file.

PROPERTY DESCRIPTION REQUIRED

esp.backup.location Directory of the backup file. If not specified,
the default server backup directory is
assumed.

No

esp.backup.filename Name of the backup file. Yes

esp.repository.directory The top level of the datastore.By default
this is Applications/Extensis/Universal
Type Server/data/vault on Macintosh or
C:\Program Files\Extensis\Universal
Type Server\data\vault on Windows.

Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.database.driver Logical name of database type to use.
Currently the only supported value is
esp.database.driver.PostgreSQL.

Yes

esp.database.username The database user name. No

esp.database.password The database password. No

esp.database.hostport Host and port used to connect to the
database. Formatted host:port, for
example: localhost:3487.

No

esp.database.datapath Path to the database. No

esp.option.backup.
stayinquiescentmode

Specifies that the server be left in quiescent
(standby) mode after restoring the
datastore. Valid values are true or false.
Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or C://Program
Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username xxx -password xxx -restoredatastore -properties properties.txt -

force

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -restoredatastore -properties

properties.txt -force
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setautostart
This command sets the whether the Type Server launches automatically when the computer starts. This
command takes a single parameter with one of two values: enabled or disabled.

-setautostart value
Windows usage example:

esp-admin -username xxx -password xxx -setautostart enabled

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setautostart enabled

setbackupdirectory
This command sets the location where backups are stored. The path must a full path and the target
location must be writable.

-setbackupdirectory fullpath
Windows usage example:

esp-admin -username xxx -password xxx -setbackupdirectory c:\this\is\my\backup\

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setbackupdirectory

"/Applications/Extensis/Universal Type Server/mybackups/"

setlogdirectory
This command sets the location where log files are stored. The path must be a complete path and the
user must have write access to the target location.

-setlogdirectory fullpath
Windows usage example:

esp-admin -username xxx -password xxx -setlogdirectory c:\logs_folder\

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setlogdirectory

"/Applications/Extensis/Universal Type Server/logs/"

setlogginglevel
This command sets the level of detail for log files written by the server.

-setlogginglevel value

The logging level specified by value is case-sensitive and must be one of error, warn, info, or debug.

Windows usage example:
esp-admin -username xxx -password xxx -setlogginglevel debug

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setlogginglevel info

setmaxbackuplogs
This command sets the maximum number of log files that are backed up.

-setmaxbackuplogs count

The number of logs specified by countmust be a whole number greater than zero. The default is 10.

Windows usage example:
esp-admin -username xxx -password xxx -setmaxbackuplogs 15

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setmaxbackuplogs 7
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setport
This command is used to set the ports to which clients connect, the User Management port
(esp.port.http) as well as the Server Administration port (esp.port.admin-web-app).

The values must be between 1 and 65536 and not conflict with any other ports currently in use.
-setport portname=value

To change the client connection and the User Management application port (JBoss HTTP / Web Service
port), use the following command:

esp-admin -username administrator -password password -setport esp.port.http=PORT_NUM

Windows usage example:
esp-admin -username xxx -password xxx -setport esp.port.http=8080

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setport esp.port.http=8080

To change the Server Administration application port (Jetty Web App port), use the following command:

esp-admin -username administrator -password password -setport esp.port.admin-web-
app=PORT_NUM

Windows usage example:
esp-admin -username xxx -password xxx -setport esp.port.admin-web-app=18081

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setport esp.port.admin-web-app=18081

setservername
This command sets the name used by Bonjour to advertise to clients.

-setservername name
Windows usage example:

esp-admin -username xxx -password xxx -setservername mysnazzyserver

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setservername mysnazzyserver
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setserversettings
Use this command to set a number of server settings using a properties.txt file (see Properties files on
page 61). All undefined values in the properties file are ignored.

-setserversettings -properties properties.txt
The following is a list of server properties available to be set using this command:

PROPERTY DESCRIPTION

esp.container.autostart This is the autostart setting of the server: enabled or
disabled.

esp.core.bonjour.name The Bonjour name of the server. Any alphanumeric value is
acceptable.

esp.core.repository.
location

The complete full path to the server vault.

esp.core.service.backup.
directory

Directory where backup files are to be written. This path
must allow changes.

esp.core.service.backup.
schedule

Backup schedule expression. Expression must adhere to the
formats supported by Quartz.

esp.core.service.logging.
level

The logging level of the server. Four case-sensitive values are
acceptable: error, warn, info, or debug.

esp.core.service.logging.
location

Complete path to the folder where logs are to be written. This
folder must allow changes.

esp.core.service.state The current state of the server can be set to one of three
case-sensitive values: started, stopped, or standby.

esp.port.admin-web-app The Server Administration port, also called the Jetty Web
App port. Any integer between 1 and 65536 inclusive.

esp.port.bootstrap-jnp The Bootstrap JNP Server Bind Address port. Any integer
between 1 and 65536 inclusive.

esp.port.http The User Management port. This port is also used for client
connection and also called the JBoss HTTP / Web Service
port. Any integer between 1 and 65536 inclusive.

esp.port.jmx-pooled The JMX Pooled Port. Any integer between 1 and 65536
inclusive.

esp.port.jmx-rmi The JMX RMI Object Port. Any integer between 1 and 65536
inclusive.

esp.port.rmi-naming The RMI Naming Service port. Any integer between 1 and
65536 inclusive.

esp.port.webservice The JBoss Webservice port. Any integer between 1 and
65536 inclusive.

Windows usage example:
esp-admin -username xxx -password xxx -setserversettings -properties properties.txt

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setserversettings -properties

properties.txt
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setstate
Use this command to change the running state of the server.

-setstate value

The server state value must be one of started, stopped, or standby.

Windows usage example:
esp-admin -username xxx -password xxx -setstate stopped

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -setstate stopped

tailadminlog
This command displays the most recent activity in the extensis.admin.log file and takes no
parameters. This log file is located in the Universal Type Server logs subdirectory.

-tailadminlog

Windows usage example:
esp-admin -username xxx -password xxx -tailadminlog

Macintosh usage example:
sudo ./esp-admin.sh -username xxx -password xxx -tailadminlog
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Contacting Extensis
Extensis
1800 SW First Avenue, Suite 500
Portland, OR 97201
Web: https://www.extensis.com/

Extensis Europe
Suites 17 & 18, Newton House
Kings Park Road, Moulton Park
Northampton NN3 6LG, United Kingdom

Customer Support
Support Form: https://help.extensis.com/hc/en-us/requests/new/

Sales
Web: https://www.extensis.com/contact-us-form/ (all regions)
We also work with resellers around the world; find one near you.

Extensis: https://www.extensis.com/
Support Form: https://help.extensis.com/hc/en-us/requests/new/
Sales: https://www.extensis.com/contact-us-form/
Extensis Channel Partners: https://www.extensis.com/resellers/

https://www.extensis.com/
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/contact-us-form/
https://www.extensis.com/resellers/
https://www.extensis.com/
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/contact-us-form/
https://www.extensis.com/resellers/
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Support
Use these resources to get answers to questions you have about Universal Type Server and other Extensis
products.

Universal Type Server
Universal Type Server Support
This page links to installers, PDF downloads, and other common support resources.

Universal Type Server System Requirements
Full system requirements and other information about the current version of Universal Type Server.

Universal Type Server Release Notes
Historical release notes for all updates to the current major release of Universal Type Server.

Universal Type Server Knowledge Base
Articles describing situational issues and solutions to user-reported problems with Universal Type Server.

Universal Type Server Videos
Get hands-on help through short video tutorials (in English).

Universal Type Server: Compatibility Guide
This page provides details on the support status of Universal Type Server with recent operating systems
and databases.

Universal Type Client: Compatibility Guide
Shows compatibility between recent Type Client versions, operating systems, and third-party
applications.

Universal Type Server Support: https://www.extensis.com/support/universal-type-server-7
Universal Type Server System Requirements: https://www.extensis.com/support/universal-type-server-

7/system-requirements
Universal Type Server Release Notes: https://www.extensis.com/support/universal-type-server-7/release-

notes
Universal Type Server Knowledge Base: https://help.extensis.com/hc/en-us/categories/360000852313
Universal Type Server Videos: https://help.extensis.com/hc/en-us/sections/360002626213
Universal Type Server: Compatibility Guide: https://www.extensis.com/support/universal-type-server-

support-guide/
Universal Type Client: Compatibility Guide: https://www.extensis.com/support/universal-type-client-

support-guide/

https://www.extensis.com/support/universal-type-server-7
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/release-notes
https://help.extensis.com/hc/en-us/categories/360000852313
https://help.extensis.com/hc/en-us/sections/360002626213
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-server-7
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/system-requirements
https://www.extensis.com/support/universal-type-server-7/release-notes
https://www.extensis.com/support/universal-type-server-7/release-notes
https://help.extensis.com/hc/en-us/categories/360000852313
https://help.extensis.com/hc/en-us/sections/360002626213
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
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General resources
Extensis Knowledge Base
Search for articles about any current Extensis product, and retired versions as well.

Support Services
Details about types of support and hours of availability, including our Support Policy.

Our Support Policy in a nutshell
Extensis provides full support for the current version of all shipping products. In addition, Extensis
provides limited support for older products up to one year after the product version is no longer offered
for sale.

Extensis’s Videos on Vimeo
Hundreds of training sessions, events, and webinars. These are mostly in English, but there are some
gems in French and German as well.

Extensis Videos on YouTube
Training, event, and educational videos.

Support Form
Use this form to submit a support case.

Provide as much of the following information as you can:
n Your email address;
n As the Subject, a brief description of the problem you are having;
n A more detailed description of the problem: when it occurs, whether you can reproduce it,

whether it has caused you to lose data, and any other details to help our staff track down the
issue.

n Your company name or account number;
n The type of support you need (generally you’ll choose Fix an Issue/Technical Support);
n The product you’re using;
n The version of the product (generally this is in the product’s About box);
n Your operating system;
n Any creative application that might also be affected.

You can also attach a screen shot or other file related to your issue.

Chat

Click at the bottom right of any page of the Extensis website. (Chat is only available between
8:00AM and 3:00PM Pacific time, Monday through Friday.)

Learn and Support
Links to white papers, testimonials, blog posts, and other resources.

Extensis Knowledge Base: https://help.extensis.com/hc/en-us/
Support Services: https://www.extensis.com/support/support-policy/
Extensis’s Videos on Vimeo: https://vimeo.com/extensis/videos/
Extensis Videos on YouTube: https://www.youtube.com/user/extensisblog
Support Form: https://help.extensis.com/hc/en-us/requests/new/
Chat: https://www.extensis.com
Learn and Support: https://www.extensis.com/learn-and-support/

https://help.extensis.com/hc/en-us/
https://www.extensis.com/support/support-policy/
https://vimeo.com/extensis/videos/
https://www.youtube.com/user/extensisblog
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/
https://www.extensis.com/learn-and-support/
https://help.extensis.com/hc/en-us/
https://www.extensis.com/support/support-policy/
https://vimeo.com/extensis/videos/
https://www.youtube.com/user/extensisblog
https://help.extensis.com/hc/en-us/requests/new/
https://www.extensis.com/
https://www.extensis.com/learn-and-support/
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Legal resources
Extensis EULA (on page 76)
The legalese description of your rights while using Universal Type Server and any associated services.

Privacy Policy
Details about information we collect and how we use it, including information specific to Europe and
California.

Privacy Shield Policy
Details about our practices regarding personal information transmitted to us from organizations subject
to protection laws in the European Economic Area and Switzerland.

Terms of Use
These terms apply to everything you do on our websites and affiliated websites. They are not the same
as terms detailed in the Extensis EULA, which apply specifically to software and related services.

Privacy Policy: https://www.extensis.com/privacy-policy/
Privacy Shield Policy: https://www.extensis.com/privacy-shield-policy/
Terms of Use: https://www.extensis.com/terms-of-use/

https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-shield-policy/
https://www.extensis.com/terms-of-use/
https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-shield-policy/
https://www.extensis.com/terms-of-use/
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Extensis EULA
CELARTEM, INC., doing business as Extensis
1800 SW FIRST AVENUE, SUITE 500
PORTLAND, OR 97201
(503) 274-2020 Phone
(503) 274-0530 Fax
https://www.extensis.com/

SOFTWARE LICENSE AGREEMENT
IMPORTANT—READ CAREFULLY. This Software License Agreement (Agreement) is a legal agreement between you
(either as an individual or a single entity) and Celartem, Inc., doing business as Extensis (“Extensis”), for Extensis’
software products, which includes the server and client software, failover software (if licensed), associated media,
printed materials, online or electronic documentation, and any subsequent updates, upgrades, bug fixes, or patches
provided by Extensis (collectively “Software”), and for any related services which may be provided by Extensis. By
installing, copying or using the Software you agree to be bound by the terms and conditions of this Agreement.

1. Definitions. For the purposes of this Agreement, the following capitalized words and phrases shall be ascribed the
following meanings:

1.1 “Authorized Server” means a computer workstation or server designated to run the Server Software for use by your
Authorized Concurrent Users and administrators of such Authorized Server. Unless you have purchased a multi-server
production license for the Software, youmay only install the Server Software on one Authorized Server for your
production purposes. Youmay make additional copies of the Software to install on a development and/or test server for
each production license of the Software that you have purchased, provided (i) all copyright, patent, trade secret,
trademark or other proprietary right or disclaimer appearing in or on the Software or any accompanying materials
(collectively “Ownership Notices”) are reproduced on each Software copy; and (ii) such Software copies are not
concurrently used for production purposes.

1.2 “Authorized Concurrent Users” means you and/or your employees or independent contractors that you authorize to
have concurrent access to and use of the Server Software pursuant to the terms of this Agreement. Your permitted
number of Authorized Concurrent Users is determined by the number of Authorized Concurrent User licenses purchased
by you under this Agreement for the applicable Server Software.

1.3 “Client Software” means that portion of the Software that is designated in its documentation for use on a
workstation that may be connected to your Authorized Server(s) when the Server Software is being used.

1.4 “Failover Software” means that portion of the Software that is designated for use on a separate server solely for
failover purposes.

1.5 “Serial Number” means a character scheme identified as the Serial Number for the Server Software and Failover
Software provided to you by Extensis.

1.6 “Server Software” means that portion of the Software that is designated in its documentation for installation and use
on your Authorized Server(s).

1.7 “Software” means the Client, Server, Failover, Module and Connector Software which may be licensed to you under
this Agreement. The Third Party Software described below are not included in the definition of “Software”.

1.8 “Software License Term” means the term of your Software license that you have purchased under this Agreement.
Your Software License Term is more fully described in Section 7 Term and Termination below.

1.9 “Third Party Software” means third party software such as software applications or components owned and licensed
by third party licensors. Third Party Software are subject to the terms set forth below.

(a) “Third Party Software Components” means Third Party Software such as libraries or other components (including
open source) that are integrated by Extensis into the Software, or are required by Extensis for use of the Software. Third
Party Software Components are subject to their respective licensors’ applicable terms and conditions which are
contained in Extensis’ or its licensor’s online electronic documentation accompanying the Third Party Software
Components. Your use of the Third Party Software Components shall be governed solely by the applicable Third Party
Software Components terms and conditions.

https://www.extensis.com/
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(b) “Third Party Software Applications” means Third Party Software that you license from the licensor and install and
maintain on your server(s). Third Party Software Applications are standalone products from the Software and any Third
Party Software Components as defined above. Third Party Software Applications are subject solely to the applicable
licensors’ terms and conditions between you and such licensor, and Extensis shall have no responsibility for such Third
Party Software Applications.

1.10 “Authorized Third Party Software Application Instances” means the number of instances that Extensis licenses to
you to connect your Third Party Software Applications to the Software.

1.11 “Module Software” means a Software component Extensis licenses to you that enables a connection between the
Server Software and your Connector Software.

1.12 “Connector Software” means a Software component Extensis licenses to you that enables a connection between the
Module Software and your Third Party Software Applications.

2. Software Licenses.

2.1 Client, Server, Failover, Module and Connector Software Licenses. During your Software License Term, Extensis
grants to you, as applicable:

(a) Server Software License. Extensis grants to you a non-exclusive, non-transferable license to install and use the Server
Software on your Authorized Server(s) and allow your permitted number of Authorized Concurrent Users to use the Server
Software.

(b) Client Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute and
install your authorized number of copies of the Client Software on the workstations or individual computers of the
Authorized Concurrent Users.

(c) Module Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute
and install your authorized number of copies of the Module Software on the workstations or individual computers of the
Authorized Concurrent Users as needed to connect to your Connector Software.

(d) Connector Software License. Extensis grants to you a non-exclusive, non-transferable license to reproduce, distribute
and install your authorized number of copies of the Connector Software on the workstations or individual computers of
the Authorized Concurrent Users as needed to connect to your Authorized Third Party Software Applications, up to your
permitted number of Authorized Third Party Software Application Instances or Nodes.

2.2 All right, title to and ownership of all applicable intellectual property rights in the Software, including but not limited
to patents, copyrights and trade secrets remain with Extensis and its licensors. Software is unpublished software, trade
secret and confidential or proprietary information of Extensis or its licensors and is commercial software developed at
private expense. The Software is comprised of “commercial items”, “commercial computer software” and “commercial
computer software documentation” as defined in FAR 2.101, DFAR 252.227-7014(a)(1) and DFAR 252.227-7014(a)(5).
Consistent with DFAR 227.7202 and FAR 12.212, any use, reproduction, display, or disclosure by the USGovernment
shall be governed solely by the terms of this Agreement.

2.3 Youmay not transfer the Software and/or any accompanying materials without the prior written consent of
Extensis, such consent not to be unreasonably withheld. Any attempted transfer without Extensis’ prior written consent,
including any transfer out of the country where the Software license was originally purchased, shall be null and void and
of no force or effect.

2.4 If you are licensed to use the Failover Software, youmay use the Failover Software on a separate server solely for
failover purposes. The Failover Software may not be used in conjunction with the Server Software on the Authorized
Server, and may only be accessed and used by your designated administrators of the designated failover server.

2.5 All rights not expressly granted hereunder are reserved by Extensis.

3. Software Access and Extensis Account. Use of the Software requires an Internet connection to activate your
Software license at time of installation and to activate additional or updated Software licenses. Use of the Software will
also require you to obtain and maintain an Extensis account (“Extensis Account”).

In addition, the Software will automatically connect to the Internet to provide youwith additional Software information
or to notify Extensis of the results of your Software activation attempts. Youmay also receive information from Extensis
related to your Software license or Extensis Account.

4. Software License Restrictions and Obligations.



- 78 -

4.1 You cannot reverse engineer, decompile or disassemble the Software, in whole or in part, except and only to the
extent that such activity is expressly permitted by applicable law. Youmay not remove, obscure or alter any Ownership
Notices appearing in or on the Software or any accompanying materials. In addition to your limited right to copy as set
forth in Section 1.1 above, youmay reproduce the Software only as reasonably necessary for your own internal disaster
recovery, backup or archival purposes only provided you retain all Ownership Notices in such copies. Youmay allow up to
the permitted number of Authorized Concurrent Users the right to copy and use the Software’s accompanying
documentation in conjunction with their use of the Software provided all Ownership Notices are retained in such copies
of the documentation. Youmay not disclose to any non-licensed concurrent user or third party nor allow any non-
licensed concurrent user or third party to have access to or use of the Software or your assigned Serial Number. Youmay
not use the Software in time sharing, hosted or subscription services, or any other manner which allows a third party to
use the Software without obtaining an authorized license from Extensis. Youmay not use, copy, modify, lend, lease, rent,
disclose, distribute, sell, license, sublicense or otherwise transfer the Software or any copies thereof, in whole or in part,
except as expressly provided in this Agreement.

4.2 Extensis reserves the right, with or without notice, to restrict your use or access to the Software, in whole or in part, if
Extensis reasonably determines that there is an unauthorized use of the Software, your assigned Serial Number, or use or
access to the Software by persons or entities who are not Authorized Concurrent Users. Such restriction by Extensis shall
not be a breach of this Agreement by Extensis, and shall be in addition to any other rights and remedies Extensis has
under law and equity.

5. DISCLAIMER OF WARRANTY. THE SOFTWARE AND ANY RELATED SERVICES PROVIDED BY EXTENSIS ARE PROVIDED
“AS IS”. EXTENSIS DISCLAIMS ALL WARRANTIESON THE SOFTWARE AND RELATED SERVICES, EITHER EXPRESSOR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIEDWARRANTYOF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, OR FOR ANY IMPLIEDWARRANTY ARISING FROM COURSE OF PERFORMANCE, COURSE OF
DEALING, USAGEOR TRADE, OR NONINFRINGEMENT. EXTENSIS DOES NOT REPRESENT ORWARRANT THAT THE
SOFTWAREOR RELATED SERVICESWILL ACHIEVE ANY SPECIFIC RESULT OR REQUIREMENT IN YOUR BUSINESS, OPERATE
WITHOUT INTERRUPTION, OR BE ERROR-FREE IN OPERATION. YOUR STATE MAY PROVIDE YOUWITH SPECIFIC LEGAL
RIGHTSWITH RESPECT TO SOFTWAREWARRANTIES; SUCH RIGHTS VARY FROM STATE TO STATE.

6. LIMITATION OF LIABILITY. IN NO EVENT SHALL EXTENSIS BE LIABLE FOR ANY DAMAGES, INCLUDING ANY THIRD PARTY
DAMAGESOR CLAIMS, RESULTING FROM LOSSOF DATA, USE, PROFIT OR REVENUE, OR FOR ANY INDIRECT, SPECIAL,
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, EVEN IF EXTENSIS HAS BEEN ADVISEDOF THE
POSSIBILITY OF SUCH DAMAGES. EXTENSIS’ AGGREGATE LIABILITY FOR ANYOTHER DAMAGES SHALL IN NO EVENT
EXCEED: (A) WITH RESPECT TO A PERPETUAL SOFTWARE LICENSE, THE AMOUNT YOU PAID FOR THE SOFTWARE AND/OR
RELATED SERVICES THAT CAUSED SUCH DAMAGES; OR (B) WITH RESPECT TO A SOFTWARE LICENSE SUBSCRIPTION, THE
AMOUNT PAID FOR THE SOFTWARE AND/OR RELATED SERVICES DURING THE PRECEDING TWELVE (12) MONTH PERIOD
FROMWHEN THE CAUSE OF ACTION AROSE. THIS LIMITATION OF EXTENSIS’ LIABILITY FOR SOFTWARE AND ANY RELATED
SERVICESWILL APPLY REGARDLESSOF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT INCLUDING
NEGLIGENCEOR ANYOTHER BASIS. BECAUSE YOUR STATE MAY NOT ALLOW THE ABOVE EXCLUSIONSOR LIMITATIONS
OF LIABILITY, THE ABOVE LIMITATIONSMAY NOT APPLY TO YOU.

7. Term and Termination. The Term of this Agreement shall commence upon the date you first install, copy or use the
Software.

7.1 If you purchased a perpetual Software license, then your Software License Term will continue indefinitely under this
Agreement unless terminated as set forth in Section 7.2 below, or when you discontinue use of the Software. If you are
licensed under a Software license subscription, then your Software License Term will be the applicable time period
purchased by you for your Software license subscription. Your Software license subscription will automatically renew at
Extensis’ then current rates unless either party provides the other party with written notice at least sixty (60) days prior
to the expiration of the then current subscription term, of its intention not to renew the Software license subscription.
Upon such proper notification to the other party, the Software license subscription will terminate at the end of such then
current term. For purposes of clarity, Software license subscriptions are non-cancelable.

7.2 Extensis may immediately terminate this Agreement if you are in default of any provision of this Agreement. In the
event of such termination, youmust either return or destroy the Software and all copies thereof, in whole or in part, and
provide Extensis with written certification of such return or destruction.

8. Consent to Use of Data
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8.1 Customer Data. Extensis collects and uses technical data and related information, including but not limited to
technical information about our customers’ devices, systems and application software, peripherals and computer
configurations used in connection with the Software so that we can improve and facilitate the provision of Software
updates, technical and product support, security measures and other services to our customers. Extensis will use this
information in an anonymized and aggregated form that will not personally identify you.

8.2 Your Data. As permitted by applicable law or per your consent, Extensis may also collect and use information
provided by you under your Extensis Account, and/or certain information related to your use of the Software and/or your
Extensis Account such as your Extensis Account number, user behavior, number of current sessions, number of seats,
number of fonts, workgroups, roles, product information and other data items. Extensis may also send, via email, phone
calls, direct in-application messaging, or some other method of communication: (a) transactional messages to facilitate
the use of the Software; or (b) marketing to provide information about the Software and other Extensis products and
Services using information including but not limited to platform version, version of the Software, license status, and
language.

8.3 Access to and use of the Software and the Extensis Account, and Extensis’ right to collect and use the data described
above (and your right to opt out) shall be in accordance with this Agreement and the following terms current at the time
of access:

Extensis’ terms of use at https://www.extensis.com/terms-of-use/ (“Terms of Use”).
Extensis’ privacy policy at https://www.extensis.com/privacy-policy/ (“Privacy Policy”).
Extensis’ privacy shield policy at https://www.extensis.com/privacy-shield-policy/ (“Privacy Shield Policy”).
Any terms in the Software documentation and any additional terms of use that might be presented to you at the time

of your Software license activation and/or access to your Extensis Account (“Additional Terms of Use”).

Extensis reserves the right to, from time to time, in its sole discretion to update or modify the Terms of Use, Privacy Policy,
Privacy Shield Policy and any Additional Terms of Use and such changes will take effect when posted by Extensis. It is
your responsibility to be aware of and abide by the most current version of the Terms of Use, Privacy Policy, Privacy
Shield Policy and any Additional Terms of Use. Your continued use of the Software and your Extensis Account constitutes
your acceptance of the most current version of these terms. If you are unable to find the information you need or have
any questions with respect to our collection and use of data and/or your ability to opt out of such collection and use,
please contact us at https://help.extensis.com/hc/en-us/requests/new/.

9. Third Party Websites. Your Extensis Account may provide links to third party websites. These links are provided for
your convenience only and Extensis reserves the right to terminate any third party website link at any time for any
reason. Extensis does not control any of these third party websites, their content, terms of use, or privacy policies.
Extensis makes no endorsement, promise, representation, warranty or guarantee and shall not have any responsibility
in connection with these third party websites, including without limitation, any products or services offered through such
third party websites. If you choose to access and use such third party websites you do so entirely at your own risk. Your
access to and/or use of these third party websites and related products and services shall be governed by the third
party website’s terms and conditions, including its terms of use and privacy policy, and applicable terms and conditions
for its products and services.

10. Audit. Extensis shall have the right to inspect and audit your records pertaining to the Software to ensure ongoing
compliance with this Agreement. Extensis or Extensis’ independent certified public accountant shall conduct such
inspection and audit at Extensis’ expense. Any inspection and audit will be conducted during regular business hours with
reasonable notice and will not unreasonably interfere with your normal business activities. Inspections and audits will
not occur more frequently than once a year, however, if past inspections and audits reveal major discrepancies, Extensis
shall have the right at any time to an inspection and audit upon written request. If any inspection and audit reveals any
underreported, unpaid or unauthorized use of the Software, then you shall promptly pay to Extensis the then current fee
representing the underreported, unpaid or unauthorized use of the Software. In addition, youwill be responsible for the
costs and expenses of the inspection and audit if such inspection and audit reveals that the then current fee
representing the underreported, unpaid or unauthorized use of the Software is equal to or greater than 5% of the
amounts actually paid by you for such Software.

11. Export. Youmay not export or re-export the Software or any direct product thereof without the appropriate United
States or foreign government export licenses and approvals.

12. Force Majeure. Extensis will not be liable to you for any delay or failure by Extensis to perform its obligations under
this Agreement or otherwise if such delay or failure arises from any cause or causes beyond the reasonable control of

https://www.extensis.com/terms-of-use/
https://www.extensis.com/privacy-policy/
https://www.extensis.com/privacy-policy/
https://help.extensis.com/hc/en-us/requests/new/
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Extensis, including, but not limited to, labor disputes, strikes, other lab or industrial disturbances, acts of God, floods,
lightning, shortages of materials, rationing, utility or communications failures, earthquakes, casualty, war, acts of the
public enemy, riots, insurrections, embargoes, blockages, actions, restrictions, regulations or orders of any government,
agency or subdivisions thereof.

13. Invalid Provision. The invalidity or unenforceability of any provision of this Agreement shall not affect the other
provisions hereof, and this Agreement shall be construed in all respects as if such invalid or unenforceable provisions
were omitted.

14. Governing Law. This Agreement shall be governed by the laws of the State of Oregon, excluding that body of law
known as conflicts of laws, and the United Nations Convention on Contracts for the International Sale of Goods.

15. Entire Agreement. This Agreement constitutes the entire agreement between the parties and supersedes all prior or
contemporaneous written, electronic or oral communications, representations, agreements or understandings between
the parties with respect to the subject matter hereto.

June 2020
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